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QD004-05 1. Introduction
1. Introduction
The aim of this manual is to provide procedural explanations of how to perform functions in 
Fuji Flexa, Fujitrax, and provide detailed knowledge about part data settings for the NXT 
machine.  The procedures outlined are to help the NXT user perform various operations in 
Fuji Flexa and Fujitrax, and help the user create part data for the NXT.  This manual is 
designed for users who already have a basic understanding of Fuji Flexa.

1.1 Notation Conventions Used in the Manual
The notation conventions employed in this manual are described below

General Notation

Mouse-related Notation

Notation sample Explanation

[File] menu Menu names and commands are enclosed in square brackets [ ].

[Open Job] 
window

Window and dialog box names which appear in the title bar are 
enclosed in square brackets [ ].

[OK] The names of toolbar buttons and command buttons that appear 
inside a window or dialog box are enclosed in square brackets [ ].

Enter key Key names are printed in bold Arial font.

Notation Explanation

Click Press and quickly release the left mouse button.

Double-click Click the left mouse button twice in rapid succession

Right-click Press and quickly release the right mouse button.

Drag Move icons, dialog boxes and windows or adjust windows by 
clicking and shifting the object in question while holding down the 
left mouse button.

Drop Release the left mouse button once an object has been dragged 
to the desired position.
NXT Programming Manual 1
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QD004-05 2. Fuji Flexa and the NXT
2. Fuji Flexa and the NXT
2.1 Introduction

The NXT represents a new concept in the SMT field and is very different from previous Fuji 
machines.  Due to these differences, there some different procedures when programming 
for the NXT in Fuji Flexa.  A brief listing of the major differences is included below.  

• The line configuration for NXT machines.

• The machine configuration for the NXT

• Line balancing is simplified

• Optimization has been improved

• Jobs are sent to the machine, not recipes

• New vision types 

It is important to point out that while there are some new procedures and options in Fuji 
Flexa for the NXT, that most of the settings and procedures have remained unchanged.  
Even in some cases, an existing process has been simplified or is easier to use. 

The next chapter, Job Builder, covers the general programming procedures for creating 
jobs and the unique or special procedures for the NXT.  The next chapter covers the part 
data settings required for the NXT in detail.  Transmission is covered in the following 
chapter.  In the following chapters, information about Fujitrax Verifier is provided.
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2. Fuji Flexa and the NXT QD004-05
MEMO:
4 NXT Programming Manual



QD004-05 3. Job Builder
3. Job Builder
3.1 Introduction

Job Builder is used to create and edit jobs.  Most of the procedures for the NXT are the 
same as previous Fuji machines.  This chapter lists the general steps for creating jobs for 
the various data types.  The Job Builder procedures that are different or unique for the NXT 
are also provided in this chapter.  Part data settings for the NXT are covered in detail in the 
next chapter.
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3. Job Builder QD004-05
3.2 General Steps to Creating NXT Jobs
This section provides a basic roadmap of procedures for creating jobs for the NXT based 
upon the different methods of entering data in the job.  

These roadmaps listed are only for general reference and are only designed to help in the 
job creation process.  There are cases when more or less steps are required depending on 
the situation.

The details for performing the unique NXT steps listed in the following procedures are in the 
following sections.  The name in the steps that are marked (NXT) are based on the name 
of that item in this manual.  For details on procedures that are not marked (NXT), refer to 
the Fuji Flexa User Manual, Chapter 2.  The procedure can be determined based upon the 
name of the corresponding step.

3.2.1 Starting by changing an existing job
Follow the steps below when changing a job that is currently complete for other machine 
types into a job with an NXT line.  Generating recipes is not necessary for the NXT unless 
one wants to view reports.  Because this job was already completed using other machines, 
panelizing, and importing data is not required.

1. Open the existing job.

2. Change the current line to the new NXT line. (NXT)

3. Enter the machine configuration and process data. (NXT)

4. Enter auto backup pin data. (NXT, only for equipped machines)

5. Change certain part data for the NXT. (NXT)

6. Assign marks to machines.

7. Line balance the work load. (NXT)

8. Optimize the job. (NXT)

9. Generate reports. (NXT)

3.2.2 Starting by manually entering sequence data
If no outside data files are available, it is possible to create a job completely through data 
entry.  Follow the roadmap below to create a basic job through manual data entry.  
Generating recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Add a line to the job.

3. Enter the machine configuration and process data. (NXT)

4. Enter auto backup pin data. (NXT, only for equipped machines)

5. Import part data into the job or create part data in the job. (NXT)

6. Add parts.

7. Import mark data into the job or create mark data in the job.

8. Create mark sequences.
6 NXT Programming Manual



QD004-05 3. Job Builder
9. Assign marks to machines. 

10.Panelize the panel (Panel Management).

11.Line balance the work load. (NXT)

12.Optimize the job. (NXT)

13.Generate reports. (NXT)

3.2.3 Starting by importing centroid CAD data
Follow the roadmap below to create a basic job by importing centroid CAD data.  
Generating recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the centroid CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Add a line to the job.

8. Enter the machine configuration and process data. (NXT)

9. Enter auto backup pin data. (NXT, only for equipped machines)

10.Panelize the panel (Panel Management).

11.Assign marks to machines.

12.Line balance the work load. (NXT)

13.Optimize the job. (NXT)

14.Generate reports. (NXT)

3.2.4 Starting by importing CCIMF files with part data
It is possible to create a job completely through importing generated CCIMF files with part 
data.  Follow the roadmap below to create a job by importing CCIMF files with part data.  
Generating recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job by importing CCIMF data.

2. Change the current line to the new NXT line. (NXT)

3. Enter the machine configuration and process data. (NXT)

4. Enter auto backup pin data. (NXT, only for equipped machines)

5. Change certain part data for the NXT. (NXT)

6. Panelize the panel (Panel Management).

7. Assign marks to machines.

8. Line balance the work load. (NXT)
NXT Programming Manual 7



3. Job Builder QD004-05
9. Optimize the job. (NXT)

10.Generate reports.  (NXT)

3.2.5 Starting by importing MCSIMF files
It is possible to create a job completely through importing generated MCSIMF program and 
part data files.  Follow the roadmap below to create a job by importing MCSIMF files.  
Generating recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job by importing MCSIMF data.

2. Import the MCS part data into the job (only necessary if part data was not imported in 
step 1).

3. Change the current line to the new NXT line. (NXT)

4. Enter the machine configuration and process data. (NXT)

5. Enter auto backup pin data. (NXT, only for equipped machines)

6. Change certain part data for the NXT. (NXT)

7. Panelize the panel (Panel Management).

8. Assign marks to machines.

9. Line balance the work load. (NXT)

10.Optimize the job. (NXT)

11.Generate reports. (NXT)

3.2.6 Starting by importing Allegro CAD data
Follow the roadmap below to create a basic job by importing Allegro CAD data.  Generating 
recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the Allegro CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Perform a verify check

8. Add a line to the job.

9. Enter the machine configuration and process data. (NXT)

10.Enter auto backup pin data. (NXT, only for equipped machines)

11.Panelize the panel (Panel Management).

12.Assign marks to machines.

13.Line balance the work load. (NXT)
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QD004-05 3. Job Builder
14.Optimize the job. (NXT)

15.Generate reports. (NXT)

3.2.7 Starting by importing Mentor CAD data
Follow the roadmap below to create a basic job by importing Mentor CAD data.  Generating 
recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the Mentor CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Perform a verify check

8. Add a line to the job.

9. Enter the machine configuration and process data. (NXT)

10.Enter auto backup pin data. (NXT, only for equipped machines)

11.Panelize the panel (Panel Management).

12.Assign marks to machines.

13.Line balance the work load. (NXT)

14.Optimize the job. (NXT)

15.Generate reports. (NXT)

3.2.8 Starting by importing CR5000 (PWS/Board Designer) CAD data
Follow the roadmap below to create a basic job by importing CR5000 CAD data.  
Generating recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the CR5000 CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Perform a verify check

8. Add a line to the job.

9. Enter the machine configuration and process data. (NXT)

10.Enter auto backup pin data. (NXT, only for equipped machines)
NXT Programming Manual 9



3. Job Builder QD004-05
11.Panelize the panel (Panel Management).

12.Assign marks to machines.

13.Line balance the work load. (NXT)

14.Optimize the job. (NXT)

15.Generate reports. (NXT)

3.2.9 Starting by importing OrCAD CAD data
Follow the roadmap below to create a basic job by importing OrCAD CAD data.  Generating 
recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the OrCAD CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Perform a verify check

8. Add a line to the job.

9. Enter the machine configuration and process data. (NXT)

10.Enter auto backup pin data. (NXT, only for equipped machines)

11.Panelize the panel (Panel Management).

12.Assign marks to machines.

13.Line balance the work load. (NXT)

14.Optimize the job. (NXT)

15.Generate reports. (NXT)

3.2.10 Starting by importing SFX-J1 CAD data
Follow the roadmap below to create a basic job by importing SFX-J1 CAD data.  Generating 
recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the SFX-J1 CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Perform a verify check
10 NXT Programming Manual



QD004-05 3. Job Builder
8. Add a line to the job.

9. Enter the machine configuration and process data. (NXT)

10.Enter auto backup pin data. (NXT, only for equipped machines)

11.Panelize the panel (Panel Management).

12.Assign marks to machines.

13.Line balance the work load. (NXT)

14.Optimize the job. (NXT)

15.Generate reports. (NXT)

3.2.11 Starting by importing Specctra CAD data
Follow the roadmap below to create a basic job by importing Specctra CAD data.  
Generating recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the Specctra CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Perform a verify check

8. Add a line to the job.

9. Enter the machine configuration and process data. (NXT)

10.Enter auto backup pin data. (NXT, only for equipped machines)

11.Panelize the panel (Panel Management).

12.Assign marks to machines.

13.Line balance the work load. (NXT)

14.Optimize the job. (NXT)

15.Generate reports. (NXT)

3.2.12 Starting by importing PowerPCB CAD data
Follow the roadmap below to create a basic job by importing PowerPCB CAD data.  
Generating recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the PowerPCB CAD data.

3. Import the BOM file.

4. Import any existing part data into the job.
NXT Programming Manual 11
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5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Perform a verify check

8. Add a line to the job.

9. Enter the machine configuration and process data. (NXT)

10.Enter auto backup pin data. (NXT, only for equipped machines)

11.Panelize the panel (Panel Management).

12.Assign marks to machines.

13.Line balance the work load. (NXT)

14.Optimize the job. (NXT)

15.Generate reports. (NXT)

3.2.13 Starting by importing PanaCAD data
Follow the roadmap below to create a basic job by importing PanaCAD data.  Generating 
recipes is not necessary for the NXT unless one wants to view reports.

1. Create a job manually.

2. Import the PanaCAD data.

3. Import the BOM file.

4. Import any existing part data into the job.

5. Create any missing part data. (NXT)

6. Import mark data into the job.

7. Add a line to the job.

8. Enter the machine configuration and process data. (NXT)

9. Enter auto backup pin data. (NXT, only for equipped machines)

10.Panelize the panel (Panel Management).

11.Assign marks to machines.

12.Line balance the work load. (NXT)

13.Optimize the job. (NXT)

14.Generate reports. (NXT)
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QD004-05 3. Job Builder
3.3 NXT Machine Setting Procedures
3.3.1 Changing the current line to a NXT line

It is easy to change any current line in a job to a new line.  This step is required when making 
jobs for the NXT by importing CCIMF or MCSIMF files into a job in Flexa or when changing 
an existing job for other machines to a job for the NXT.  When adding the line, a line that 
has been previously setup for transmission is used.  This makes adding lines easier and 
more error free, because the basic NXT data already exists and the NXT in the job will 
match the NXT for transmission.  If the NXT lines have not been setup for transmission, 
then this must be done before adding an NXT line to the job is possible.

Changing the line for the top side of the panel.
1. Select the [Top] tab from the job information bar.

2. Right-click in the data area for [Top] and select [Select line…] from the shortcut menu.  
The [Select Line] dialog box displays.

3. Select the factory for the desired line and select the desired NXT line from the list that 
displays and click [OK].  The dialog box closes and the machines from the selected line 
are added to the job.

Note: If there are no other Fuji machines in the line, then there most likely will only be one NXT machine.  For 
further details, refer to the chapter about setting up an NXT line in the NXT Setup Manual. 

When the line is added, the default machine data for each machine is also brought into the 
job.

Changing the line for the bottom side of the panel.
1. Select [Flip Panel] from the [View] menu and then select the [Bottom] tab from the job 

information bar.

2. Right-click in the data area for [Bottom] and select [Select line…] from the shortcut 
menu.  The [Select Line] dialog box displays.

3. Select the factory for the desired line and select the desired line from the list that 
displays and click [OK].  The dialog box closes and the machines from the selected line 
are added to the job.

Note: If there are no other Fuji machines in the line, then there most likely will only be one NXT machine.  For 
further details, refer to the chapter about setting up an NXT line in the NXT Setup Manual. 

When the line is added, the default machine data for each machine is also brought into the 
job.

3.3.2 Adding an NXT line to a job
It is easy to add any current line to a job.  This step is required with making new jobs for the 
NXT.  When adding the line, a line that has been previously setup for transmission is used.  
This makes adding lines easier and more error free, because the basic NXT data already 
exists and the NXT in the job will match the NXT for transmission.  If the NXT lines have not 
been setup for transmission, then this must be done before adding an NXT line to the job 
is possible.

Adding the NXT line for the top side of the panel.
1. Select the [Top] tab from the job information bar.
NXT Programming Manual 13



3. Job Builder QD004-05
2. Right-click in the data area for [Top] and select [Select line…] from the shortcut menu.  
The [Select Line] dialog box displays.

3. Select the factory for the desired line and select the desired NXT line from the list that 
displays and click [OK].  The dialog box closes and the machines from the selected line 
are added to the job.

Note: If there are no other Fuji machines in the line, then there most likely will only be one NXT machine.  For 
further details, refer to the chapter about setting up an NXT line in the NXT Setup Manual. 

When the line is added, the default machine data for each machine is also brought into the 
job.

Adding the NXT line for the bottom side of the panel.
1. Select [Flip Panel] from the [View] menu and then select the [Bottom] tab from the job 

information bar.

2. Right-click in the data area for [Bottom] and select [Select line…] from the shortcut 
menu.  The [Select Line] dialog box displays.

3. Select the factory for the desired line and select the desired line from the list that 
displays and click [OK].  The dialog box closes and the machines from the selected line 
are added to the job.

Note: If there are no other Fuji machines in the line, then there most likely will only be one NXT machine.  For 
further details, refer to the chapter about setting up an NXT line in the NXT Setup Manual. 

When the line is added, the default machine data for each machine is also brought into the 
job.

3.3.3 Configuring an NXT machine
Data about the configuration of the NXT must be entered.  When an NXT machine with a 
certain name is added for the first time, the default information is used.  This data must be 
checked and edited if it does not match the actual machine with that name.

Entering NXT configuration data
1. Select the [Top] or [Bottom] tab from the job information bar depending on which side of 

the panel the machine is located for which the configuration data needs to be edited.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the NXT machine to set the configuration file for to display the 
items for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  The first tab 
is [General] and this is the location where the machine configuration data is set.  There 
are two groupings of data.  Data in the [Machine Setup] affect the conveyor system, and 
the settings in the [Optimization] affect the optimization of the NXT machine.  Refer to 
the tables below for information on the settings.
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Machine Setup

Optimization

Setting Description

Fix Rail This specifies whether or not the reference rail for the 
second lane can move to different positions.  If this is set to 
“Yes” the reference rail cannot move to different positions 
and a setting must be specified for [Rail Width].  This is the 
location that the refence rail for lane 2 will be positioned.  

Rail Width This setting only displays when the setting for [Fix Rail] is 
“Yes”.  This setting specifies the location at which the 
reference rail for lane 2 will be fixed.

Board Flow This specifies the direction in which the panels flow 
through the machine.  This settings does not actually 
control the direction in the machine but is used for job 
related processing in Fuji Flexa.

Setting Description

Mark Reset This specifies whether or not the fiducial marks for the 
sequences are cleared and reassigned.  If this is set to “<n/
c>”, only sequences at have no fiducial mark assignment 
at all, have fiducial marks assigned.  If this is set to “Reset” 
then all fiducial mark assignments are cleared for all 
sequences and then they are reasigned.

Mark 
Compensation 
Count

This specifies how many marks are to be used for aligning 
the sequences when assigning fiducial marks.  If this 
setting is changed then only marks that have no fiducial 
assignments are affected or all sequences are affected 
only if the [Mark Reset] setting is “Reset”.

Feeder Duplication This specifies whether or not parts with many placements 
will be broken up into multiple feeders and set into different 
modules.  If this is set to “Yes”, parts with many placements 
will be set in multiple feeders and placed on multiple 
modules. 

Use Current Feeder 
Setup

When the [Allocate Feeders] option is selected for 
optimization, this specifies whether or not the current 
feeder setup will be changed or not.  If the is set to “No” and 
the [Allocate Feeders] option is selected for optimiztion, 
then the current feeder positions and settings are 
completely ignored and all feeders are redistributed.  If 
there are variable status feeders that are not being used in 
the current job in the feeder setup, these feeders are 
removed.

Conveyor Mode This settings specifies the panel conveyance mode to be 
used for production for determining optimization.

Target Conveyor This specifies the target lane on which the job will be 
optimized.  If set to “Lane 1”, then the job is optimized with 
the premise that the panels are to be loaded on lane 1.
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Optimizer Type This setting specifies the level of optimization to be 
performed.

“Speed” performs optimization with a priority on achieving 
a relatively fast cycle time and processing is performed 
quickly.

“Optimal” performs optimization with a priority on achieving 
the fastest cycle time and processing takes longer.

“Time Limit” performs processing the same as “Optimal” 
but within a specified time limit. 

Time Limit This only displays if [Optimizer Type] is set to “Time Limit”.  
This specifies the time limit in minutes that the optimizer 
has to complete processing.

Optimize For Single 
Module Production

This specifies whether or not paired module production is 
used for panels between 250 and 305 in length.  This 
setting has no bearing for panels outside of this range.  
When setting to "No" and the panel size is within the range, 
the M3 modules are automatically paired for paired 
production.  If set to "Yes" and the panel size is within the 
range, the M3 modules are not paired.  For panels smaller 
than the range, M3 modules are never paired.  For panels 
larger than the range, M3 modules are always paired.

Optimize Insert 
Order Only

When this setting is set to “No”, insert order, feeders, head 
setup, nozzle stations and other items can be optimized/
changed during optimization.  Only the insert order is 
changed during optimization when this setting is “Yes”.

Optimize Panel 
Stopping Position 
Offset

This specifies whether or not the panel stopping position is 
optimized for paired module production.  This is only for M3 
modules when they are performing paired module 
production.

Allocate parts to M6 
modules

This specifies whether or not to allocate parts that are in 
the head interference area during paired module 
production to M6 modules if possible.  By setting this to 
“Yes”, head waiting time during paired module production 
is reduced.  However, more parts are assigned to the M6 
module.

Used feeder type Specify the whether of not reel holders are on the feeders.  
If set to “Reel holder”, the optimizer positions feeders in the 
feeder setup considering that the feeders have reel 
holders.  If this is set to “Reel holder-E”, the optimizer 
positions feeders in the feeder setup considering that 
feeders have no reel holders and a bucket type feeder 
pallet is used.

Optimize Nozzle 
Station

This specifies whether the nozzle allocation should be 
optimized or not.  If this is set to “Yes” the nozzles in the 
nozzle station will be changed to be “optimized” for 
production.  If this is set to “No” then optimization is 
performed without changing the nozzle setup.

Nozzle station 
nozzle allocation 
method

Specify the nozzle station nozzle arrangement method. 
"Minimum" arranges for the minimum number nozzles 
required by the head.  "Maximum" arranges for the 
maximum number of nozzles allowable in the station. 

Setting Description
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The new settings will take effect the next time the job is transmitted to the machine or 
optimization is performed.

Distributing the same part to multiple modules
1. Select the [Top] or [Bottom] tab from the job information bar depending on the side of 

the panel the machine data to be edited is located.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the machine to display the items for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. Select the [General] tab found in the bottom of the [Machine Configuration] Pane.

6. Double-click the data cell for [Feeder Duplication] located near the bottom of the 
available options to display a drop-down list.

7. Select “Yes” to distribute high part count parts to multiple modules.

8. Optimize the job for the changes to take effect.  Parts that can be placed on more than 
one module are distributed to modules with a compatible configuration.

Specifying the modules for an NXT
After adding the NXT line, it is very important to configure the modules to match the 
modules in the current machine.  Since items and modules are easily interchanged, always 
be sure to check the current module configuration.

1. Select the [Top] or [Bottom] tab from the job information bar depending on which side of 
the panel the machine is located for which the configuration data needs to be edited.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the NXT machine to set the configuration file for to display the 
items for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  The second 
tab is [Modules] and this is the location where the modules are set.  Click this tab.

6. Click [Select] from the [Module Edit] group.  A small dialog box displays with a 
representation of the current NXT module configuration.  Click a module in this dialog 
box to jump to the information for that module.  By using this dialog box, it is easy to 
navigate and understand the current module configuration.  In addition, this dialog box 
can be used to jump to different modules on other tabs such as [Nozzle Changer Setup], 
and [Feeder Setup].

7. Check the current modules.  If the number and type of modules is correct then proceed 
to step 16.

8. If the number of modules is incorrect, click [Add] and in the dialog box that displays, 
specify the position for the new module.  Once the desired position has been specified, 
click [OK] and the module is added to the specified position using the default module 
settings.  Continue adding modules until the number of modules is correct for the NXT 
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machine.

Note: The NXT “machine” in Fuji Flexa is comprised of multiple bases that are next to each other.  One NXT 
machine can be created with up to 32 modules in this manner (e.g., eight 4M bases with 4 M3 modules 
on each base).  In this module configuration, the NXT machine will have the number of modules that all 
of the bases put together have regardless of the fact that the bases are different.  For details on making 
the line configuration settings for the NXT, refer to the “Setting Up a Line with a NXT” chapter in the NXT 
Setup Manual.

Note: Do not use [Copy] to add a new module.  Copy only will replace the settings of an existing module with 
the settings from the copied module.  This is a convenient feature to use after adding new modules to 
apply the same settings to the new modules.

9. Once all of the necessary modules are present, select the first module and check the 
module configuration.

10.If the confguration needs to be changed, click the [...] button to the right of the module 
name title.  A dialog box displays with the possible module type and stage type 
configurations.

Note: It is possible to change the individual values for the different fields.  However, if a invalid setting is 
selected, the text for the settings turns red to indicate that the selected values are incorrect.

11.Click the button that has the correct module type and stage configuration for the selected 
module.  The selected settings are applied to the selected module and the possible 
choices for the selected option then are displayed.  There are no more options if a 
conveyor unit is selected so the dialog box is closed.

12.Click the button that has the correct head type for the selected module.  The selected 
settings are applied to the selected module and the possible choices for the selected 
option then are displayed.  There are no more options if a glue head is selected so the 
dialog box is closed.

13.Click the button that has the correct nozzle station for the selected module.  The 
selected settings are applied to the selected module and the dialog box is closed.

14.Specify any of the other settings that have a white background for the value cells as 
necessary.  Refer to the table below for information.  

15.Repeat steps 10 to 14, while selecting the next module in the machine until all of the 
modules in the machine have the correct configuration.

16.If any pairs of M3 modules are to perform paired production, display the modules and 
change the setting [Perform Paired Module Production] to “Yes” for both modules.  
Specify any required stopping position offset.  Repeat until all M3 modules that are to 
perform paired module production have the correct setting.

Note: Paired module production is when two M3 modules clamp a single panel across the conveyors for the 
modules and place parts on the same panel.  Paired production can only be performed between set 

Setting Description

Coplanarity This specifies whether or not the module is equipped with 
coplanarity measuring unit.  This is a NXT option.  

Camera Position This setting only displays when for M6 modules and is 
used to specify the position of the camera.  Only if a M6 has 
a feeder pallet is this setting valid.

Actual Cycle Time 
Difference

Make a setting here when a difference between the 
projected cycle time and actual production cycle time 
exists for the module.  Specify the difference between 
these two cycle times.
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pairs of M3 modules.  For example, modules 1 and 2 can share production together, however, modules 
2 and 3 cannot.

17.If the created module configuration is the standard setup for the selected NXT machine, 
right-click the grey area outside of the setting area in the [Modules] tab and select [Save 
as the Default Machine Configuration] to save the current module configuration as the 
standard configuration.  When the same machine is brought into a job from this point, 
the module configuration will be the same as that just specified.

Specifying NXT machine processing options
Data about the processing of the job for the NXT machine must be entered.  When a 
machine with a certain name is added for the first time, the default process options are 
used.  This data must be checked and edited if it is not the correct processing options for 
that machine.

1. Select the [Top] or [Bottom] tab from the job information bar depending on which side of 
the panel the machine is located for which the process options need to be edited.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the machine to set the processing options for to display the 
items for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Select the 
[Process Options] tab to display the available process options for the machine

6. Enter the appropriate process settings for the machine.  The process options above the 
[Panel Stopping Position Correction] settings are the same as the process options for 
standard Fuji machines.

7. Enter the appropriate panel stopping position correction settings process settings for the 
machine if the panel stopping position correction function is turned on.  Refer to the table 
below for information on these settings.

The new settings will take effect the next time the job is transmitted to the machine or 
optimization is performed.

Setting Description

Scan Area X/Y This specifies the size of the area in the X- and Y-direction 
checked for the panel edge when correcting the panel 
stopping position.  

Shutter Speed This setting specifies the shutter speed used by the mark 
camera when checking for the panel edge.  The larger the 
value, the slower the shutter speed and the image 
becomes brighter.

Color Specify which lighting should be used to check for the 
panel edge.  Different settings will be required depending 
on the color of the panel.

Pattern Specify which lights should be used to check for the panel 
edge.  Different settings will be required depending on the 
color of the panel.
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Specifying the head setup for an NXT
Making settings in the [Head Setup] tab is not normally necessary.  The head setup will be 
automatically reconfigured based upon the nozzles in the nozzle changer during 
optimization.

1. Select the [Top] or [Bottom] tab from the job information bar depending on which side of 
the panel the machine is located for which the configuration data needs to be edited.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the NXT machine to set the configuration file for to display the 
items for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Select the 
[Head Setup] tab.

6. Use the [Module] drop-down list to select the desired module to display.

7. Click the position data field and then the arrow to display a drop-down list of the available 
nozzles.  Click to select the desired nozzle for that position.

Note: It is possible to specify nozzles for multiple positions at a time.  Select the multiple nozzle positions for 
the head and then right-click in the window.  Select [Select Nozzles] and then select the desired nozzle 
for the selected positions from the drop-down list and click [OK].

8. Repeat the previous step until all of the desired nozzles for the positions have been set.

9. If any other heads need to have nozzles set, return to step 6 and select the new module 
on which the next head is set.

Specifying the nozzle changer setup for an NXT
Making settings in the [Nozzle Changer Setup] tab is necessary if the nozzles in the 
machine do not match the nozzles currently in this tab or if different nozzles are to be used 
during production.

1. Select the [Top] or [Bottom] tab from the job information bar depending on which side of 
the panel the machine is located for which the configuration data needs to be edited.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the NXT machine to set the configuration file for to display the 
items for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Select the 
[Nozzle Changer Setup] tab.

6. Use the [Module] drop-down list to select the desired module for which to set the 
nozzles.

7. Click the position data field and then the arrow to display a drop-down list of the available 
nozzles.  Click to select the desired nozzle for that position.

Note: It is possible to specify nozzles for multiple positions at a time.  Select the multiple nozzle positions for 
the changer and then right-click in the window.  Select [Select Nozzles] and then select the desired 
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nozzle for the selected positions from the drop-down list and click [OK].

8. Repeat the previous step until all of the desired nozzles for the positions on the nozzle 
changer have been set.

9. If any other nozzle changers need to have nozzles set, return to step 6 and select the 
new module on which the next nozzle changer is set.

Specifying the available nozzles for a machine
By setting which nozzles are available for the NXT machine, only the nozzles specified as 
being available display when a user is selecting a nozzle for a position.  This ensures that 
a nozzle is not accidentally selected that is not available and reduces the amount of choices 
in the nozzles drop-down list, thus allowing easier selection.

1. Select the [Top] or [Bottom] tab from the job information bar depending on the side of 
the panel the machine to be edited is located.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the machine to set the available nozzles for to display the items 
for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Select the 
[Nozzle Available] tab and the available nozzles for the machine display.

6. Double-click in the data cell under [Available] that is on the row for the desired nozzle 
and a drop-down list box displays.  Select “Yes” if that nozzle is available for that 
machine, or “No” if the nozzle is not available for that machine.  Repeat until all of the 
available and unavailable nozzles have been specified.

Specifying the available feeders for a machine
By setting which feeders are available for the NXT machine, an unavailable feeder will not 
be selected when optimization is performed.

1. Select the [Top] or [Bottom] tab from the job information bar depending on the side of 
the panel the machine to be edited is located.

2. Double-click the name of the line to display the machines in that line.
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3. Double-click the name of the machine to set the available feeders for to display the items 
for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Select the 
[Feeder Available] tab and the available feeders for the machine display.

6. Double-click in the data cell under [Available] that is on the row for the desired feeder 
and a drop-down list displays.  Select the “Yes” if that feeder is available for that 
machine, or “No” if the feeder is not available for that machine.  Repeat until all of the 
available and unavailable feeders have been specified. 

The new settings will take effect the next time optimization is performed.

3.3.4 Setting auto backup pins (from NXT V3.10 and higher)
This is used with the optional automatic backup pin function on the NXT.  It is necessary to 
have Fuji Flexa V1.5.4 or higher and NXT control software V3.10 or higher in order to use 
this function.  In addition, if the NXT does not have this option, then any settings made 
regarding this are ignored by the machine.

1. Select the [Top] or [Bottom] tab from the job information bar depending on the side of 
the panel the machine to be edited is located.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the machine for which to set the auto backup pins.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Select the 
[Process Options] tab and the process options for the machine display.

6. Select “Yes” from the drop-down list from the [Use Auto Backup Pin] setting in the 
[Backup Plate] group.

Note: If a special backup plate is required, enter the name of the required backup plate in the [Backup Plate 
Name] field on this page.

7. Double-click [Backup Pin] in the [Top]/[Bottom] tab in the job information bar.

8. Select [Display] from the [Format] menu and click the [Backup Pin] tab.

9. Set the desired colors for the top and bottom parts in order to distinquish between them 
better in the view and click [OK].
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10.In the first empty row, double-click in that row’s cell in the [Level] column and a drop-
down list displays.  Select the level for the backup pin.  Refer to the table below for 
details.

11.Click the data cell in the [Ref] column for that row to select that item.

12.Enter a unique reference designator for the backup pin.  It is possible to use the default 
name, as long as it is not used anywhere else in the job as a reference designator.

13.Click the data cell in the [Pos X] column for that row to select it.

14.Enter the X-coordinate for the backup pin to be set.  This coordinate is based on the 
panel origin position.

Note: If the coordinate position is not known, click in the view and move the pointer to the position to set the 
backup pin.  Note the coordinates that display in the left side of the status bar.  These are the values 
that should be entered as the X- and Y-coordinates for the backup pin.

15.Click the data cell in the [Pos Y] column for that row to select it.

16.Enter the Y-coordinate for the backup pin to be set.  This coordinate is based on the 
panel origin position.

17.If the [Level] setting for the backup pin is “Local”, then select that row by clicking the gray 
box to the left of the row.  Right-click and select [Edit Part Info].  Click to button to the 
right of the [Ref. list] display and select the reference designator for the part that the 
backup pin is to be linked with from the displayed list.  Click [OK] and then [OK] in the 
[Edit Part Info] dialog box.  The backup pin is then linked to the specified part and will be 
set in the module that places that part.  

Note: It is possible to select multiple parts in the displayed list.

18.Repeat steps 10 to 17 until all of the desired backup pins have been specified for that 
side of the panel.

19.Repeat these procedures to make backup pin settings for the other side of the board.

3.3.5 Specifying a panel edge sequence (from NXT V3.10 and higher)
This is used for checking the panel stopping position when the panel stopping position 
function is being used on the NXT.  It is necessary to have a compatible version of Fuji 
Flexa and NXT control software V3.10 or higher in order to use this function and the panel 
stopping position correction function must be enabled in the machine configuration.  In 
addition, if the panel stopping position correction function is turned off in the machine 
configuration, then any settings made regarding this are ignored by the machine.

Making machine configuration settings
The following procedures are used to turn on the panel stopping position correction function 

Setting Description

Global When this is selected, the backup pin is placed at the 
specified position in all modules.  This is the default setting.

Local When this is selected, the backup pin is placed at the 
specified position only in the module placing a specified 
part.  When this setting is selected, the related part 
reference number must be specified in the [Edit Part Info] 
dialog box for that backup pin.
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for the machine.

1. Double-click the [Internet Explorer] icon on the desktop.

2. Enter the address (URL) "http://<NXT accessory software server name>/fujiweb" and 
then press Enter.  If the server computer is located and the server is running, a loading 
page displays.  Once the necessary items have been loaded, the [Home] page displays.  
This page provides basic production information for the NXTs.

3. From Floor Monitor, click the machine or module number for the NXT for which Machine 
Accessories is to be used.  The Machine Accessories log on page is displayed

4. Enter or select a user ID from the drop-down list.

5. Enter the password for the user and click [Log on].  Once connected to the machine, the 
top diagram of the picture will match the machine that was selected.  In the lower left 
side, the menu for possible actions displays.  In the lower right side, the details for the 
selected item displays.

6. Click [Machine Configuration] from [Menu].  Accessory Software connects to the 
machine and receives the machine information.  When completed, the settings page 
displays.

7. Select [Loader Settings] from the [Category] drop-down list.  When a category has been 
selected the settings shown under the list automatically change to the selected 
category.  

8. Select the [ON (Panel Edge)] option for [Panel position correction].

9. Once the settings have been completed, click [Send to Machine] to send the new setting 
to the machine.  During transmission to the machine, the operation panel will change to 
the transmission display.  When sending the new setting is complete, a page displays 
with that message. 

10.Once all changed settings have been sent to the machine, click [Close].

Making a panel edge check sequence in Fuji Flexa
1. Select the [Top] or [Bottom] tab from the job information bar depending on the side of 

the panel the panel edge sequence is to be added.

2. Double-click [Coordinate] to display the “All” window.

3. There are several tabs at the bottom of the [Coordinate] pane.  Select the [Mark] tab and 
the mark sequences are displayed.

4. Scroll to the bottom of the sequences until the last blank line is visible.

5. Click in the blank data cell for “Board” and select the “0” from the drop-down list.

6. Press Tab to move to the type data cell, and select “Panel Edge” from the drop-down list.

7. Press Tab to move to the level data cell, and select “Panel” from the drop-down list.

8. Press Tab to move to the reference data cell, and enter a unique reference number.

9. Press Tab to move to the X-position data cell, and enter the X-position for the panel 
edge to be checked.  This position must be inside of the panel.  Refer to the “Cautions 
regarding panel edge position” section below for information about the panel edge 
checking position.
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10.Press Tab to move to the Y-position data cell, and enter the Y-position for the panel 
edge to be checked.  Generally, this position will be 12 mm and is the Y-position that the 
felt paper is usually applied on the backup plate.  This position must be inside of the 
panel.  Refer to the “Cautions regarding the panel edge check position” section below 
for information about the panel edge checking position.

11.Press Tab to move to the mark name data cell, leave this field blank. 

12.Enter any other information as necessary.

Note: It is not possible to make 2 or more panel edge check sequences for a panel.

Cautions regarding the panel edge check position
Be sure to note the following caution points about the panel edge check position.

• The X- and Y-position must be inside of the panel, but very close to the edge 
position to be checked (within the scanning area).

• Always specify a section with a straight line of the panel edge.  Do not include a 
cut-out section in the scan area as panel play may affect positioning.

• When panel rotation is specified, set the coordinates based on the panel 
orientation at the time of transportation on the conveyor.

• Specify a location that does not contain any bright objects such as backup pins, 
for times when there is no panel on the conveyor.  Nor place any bright items in 
the specified area (such as backup pins, soiled/grease areas, soft backup pin 
tips).

Making job machine configuration settings in Fuji Flexa
Generally the machine configuration settings for the panel edge will be appropriate and do 
not need to be changed.  Follow the prodecures below if the settings need to be changed.

1. Select the [Top] or [Bottom] tab from the job information bar depending on the side of 
the panel the machine to be edited is located.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the machine for which to set the auto backup pins.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Select the 
[Process Options] tab and the process options for the machine display.

6. Enter the appropriate panel stopping position correction settings process settings for the 
machine if the panel stopping position correction function is turned on.  Refer to the table 
below for information on these settings.

Setting Description

Scan Area X/Y This specifies the size of the area in the X- and Y-direction 
checked for the panel edge when correcting the panel 
stopping position.  
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3.3.6 Assigning an alternate feeder
The method for assigning a fixed alternate feeder for an NXT is different than other 
machines.  For other machines an alternate feeder loop has to be created while for the NXT 
an extra feeder with the part is just added to the module and the NXT will automatically use 
this extra feeder as an alternate feeder and a loop does not have to be created.    It is not 
possible to specify which feeder is to be used next for the NXT if there are two or more 
alternate feeders as this is decided by the machine.  If using Fujitrax Verifier, use the 
dynamic alternate feeder function. 

1. Select the [Top] or [Bottom] tab from the job information bar depending on which side of 
the panel the machine is located for which the configuration data needs to be edited.

2. Double-click the name of the line to display the machines in that line.

3. Double-click the name of the NXT machine to set the configuration file for to display the 
items for that machine.

4. Double-click [Configuration] under the machines name and a window displays in the 
data area.

5. There are several tabs at the bottom of the [Machine Configuration] pane.  Click the 
[Feeder Setup] tab.

6. Select the module for which the alternate feeder is to be added.

7. Select the feeder position in which to add the alternate feeder by selecting the gray 
extreme left cell of that row for the feeder.

8. Right-click and select [Add Feeder] from the shortcut menu and the [Add Feeder] dialog 
box is displayed.

9. Select the part for which this feeder is to be the alternate feeder from the drop-down list 
and click [OK].  The extra feeder is added and the NXT will use this extra feeder as an 
alternate feeder.

Shutter Speed This setting specifies the shutter speed used by the mark 
camera when checking for the panel edge.  The larger the 
value, the slower the shutter speed and the image 
becomes brighter.  Generally, the default setting is 
appropriate.

Color Specify which lighting should be used to check for the 
panel edge.  Different settings will be required depending 
on the color of the panel.  Generally, the default setting is 
appropriate.

Pattern Specify which lights should be used to check for the panel 
edge.  Different settings will be required depending on the 
color of the panel.  Generally, the default setting is 
appropriate.

Setting Description
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3.4 Line Balancing
Line balance is performed to balance the workload of each machine as much as possible.  
Due to the unique nature of putting multiple NXT bases together to create one large NXT 
machine, the concept of line balancing has greatly changed for lines with only NXT bases.  
For line with only NXT bases made up into one NXT machine, all parts will be simply 
assigned to the NXT machine.  This will still be an important step for lines with multiple 
machines though.

Note: This means that if a NXT machine is the only machine in a line then the assign part command can be 
used to simply assign all of the parts to the NXT machine.

1. Select [Line Balance...] from the [Tools] menu and the [Line Balancer Options] dialog 
box displays.

2. Select the appropriate option and click [Start] to start the line balancing process and the 
[Line Balancer] dialog box displays with the current status of the balancing process.  If 
the option “Do not use current feeder allocation” is used, then all of the parts are 
assigned to the different machine without considering any parts already set in the feeder 
setups.  If the option “Use current feeder allocation” is selected, then parts are assigned 
to machines while considering any parts already present in the feeder setup.  This 
means that if a part is already in the feeder setup for a machine, then the matching part 
is possibly assigned to that machine.

3. If there are any errors, click [Error Details…] to view the errors.  Once completed, click 
[Close] to close the dialog box.  If there were errors, note what the errors were and 
correct them and then rebalance the line again.
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3.5 Optimizing
After balancing the line, the parts need to be distributed to the different modules and the 
sequences for each module need to be arranged in the optimum order to minimize cycle 
time.  The optimizer is used to arrange the sequences in the best order.  In addition to the 
optimizer within Job Builder, there is another optional optimizer for optimizing different jobs 
or sides.  NXT Dual Production Optimizer is capable of optimizing two different jobs to run 
on different lanes or two sides of a panel using two different lanes.  For procedures on using 
this optimizer, refer to the section Dual job optimizing.

3.5.1 Optimizing in Job Builder
The following procedures are used for optimizing one job only.

1. Select [Optimize...] from the [Tools] menu to display the [Optimize Options] dialog box.

2. To optimize the feeder arrangement, select the [Allocate feeders] option.  After 
specifying the desired settings, click [OK] to display the [Select Machine] dialog box.

3. Select the desired machines, and click [OK].

4. Click [Yes] in the confirmation dialog box to confirm that optimization is to be performed 
for the selected machines.

5. The [Optimize] dialog box displays.  In this dialog box, the status of the optimization 
process displays along with any errors.  If any errors occur, click [Error Details] to display 
further details.  Click [Close] when the optimization process is complete.

Note: Once the job has been optimized, it can be transmitted to the NXT machine.  It is not necessary to 
generate recipes for the NXT.

3.5.2 Dual job optimizing
In order to perform dual job optimization, it is necessary to have the optional software, NXT 
Dual Production Optimizer, installed on the computer.

1. Ensure that both jobs for which optimization is to be performed are complete in the terms 
that they can be used to produce panels.

2. Click the [Start] button, point to [Programs] > [Fuji Flexa] and then click [NXT Dual 
Production Optimizer].  The first step of the wizard displays.

3. Specify whether optimization to to be performed between two different jobs or for both 
panel sides for one job by selecting the appropriate option.

4. After selecting the desired job option, click the button with the three periods to the right 
of the job text box for lane 1.  A dialog box displays the available jobs.

5. Select the desired job to be produced using lane 1 and click [OK].  The name of the job 
then displays in the job text box.  

Note: If an error occurs about not being able to open the job,  ensure that the job is not currently opened.  
Opened jobs cannot be selected.

6. Specify the panel side for the selected job by using the drop-down list to the left of the 
button.

7. If two separate jobs are to be optimized, then repeat steps 4 to 6 for Lane 2.

8. Click [Next].
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9. Select the machine to be optimized,

10.Select any desired optimization options and clear any unwanted options.

11.Click [Next] and the optimization process begins.  The current status of the optimization 
process displays in a message box.  When the optimization processing is completed, 
the final step of the wizard displays with the cycle time for each module.

12.To view a text file with a breakdown of the cycle times, click [Report].  To save the 
optimization processing back to the jobs, click [Save].  When [Save] is clicked, the 
results are saved.  If the optimization results are not to be used, proceed to the next step 
without clicking [Save].

13.Click [Cancel] and the wizard is closed.
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3.6 Generating Reports
With the NXT, it is not necessary to generate recipes in order to transmit the job to the 
machine.  Reports are only generated during the recipe generation process.  Therefore, in 
order to view reports, it is necessary to generate recipes.  If data in the job has been 
changed that needs to be reflected in a report, then recipes need to be regenerated for the 
change to be reflected (e.g., feeder position has been moved, part has been added). 

3.6.1 Manually generating reports
1. Select [Generate Recipes...] from the [Tools] menu to display the [Select Machine] 

dialog box.

2. Select the NXT machine, and click [OK] to generate recipes.

3. Click [Yes] in the message to confirm that recipes for the selected machines are to be 
generated. 

4. The [Generate Recipes] dialog box displays.  In this dialog box, the status of the recipe 
generation process displays along with any errors.  If any errors occur, click [Error 
Details] to display further details.  Click [Close] when all of the recipes have been 
generated.

Note: Reports for the selected machines are automatically generated when recipes are generated.  To display 
the available reports, double-click [Report] found in the page for the [Top] or [Bottom] tab.

3.6.2 Automatically generating reports when the job is saved
When this option is used, reports and recipes for all machines are automatically generated 
every time the job is saved.  This does increase the amount of time it takes to save a job.

1. Select [Options…] from the [Tools] menu and the [Options] dialog box displays.

2. Select the [Recipe Creation] tab.

3. To generate recipes and reports every time a job is saved, select the check box for 
[Generate recipes on save] and click [OK]

Note: To display the available reports, double-click [Report] found in the page for the [Top] or [Bottom] tab.

To stop Fuji Flexa from generating recipes and reports every time a job is saved, perform 
the above procedures, but clear the check box for [Generate recipes on save].
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4. Part Data Settings
4.1 Introduction

The NXT requires part data the same as other Fuji machines and the most of part data 
settings are the same as other Fuji machines.  One of the major areas where part data 
settings are different for the NXT machine versus other Fuji machines is the vision related 
settings.  This chapter lists the part data settings used by the NXT and provides details on 
the settings that are different from other Fuji machines.  For details on theThis is a machine 
control setting. settings that are the same as other machines, refer to the Fuji Flexa 
Reference Manual or the Fuji Flexa online help file (select the data item to check in the 
editor and then push F1 on the keyboard, and the help file displays the information about 
that item).  The part data settings in this are broken down into three groups that correspond 
to the way the settings are grouped when using relational mode for part data in Fuji Flexa.

Part data is created and edited with Part Editor or if the part data is using relational mode, 
Part Number Editor, Shape Editor, and Package Editor.  In addition, part templates are 
created and edited with Template Editor.  Part data can be created manually, by importing 
data, or by using the New Part Wizard.  For procedures on using these items, refer to the 
Fuji Flexa User Manual.
NXT Programming Manual 31



4. Part Data Settings QD004-05
4.2 Part Data
The following list is the part data settings used by the NXT for part data.  

The settings for items with an O in the “Chg” column can be changed in MEdit.  The settings 
for items with an X in this column cannot be changed in MEdit.  

4.2.1 Part data details
Part shape
Specify the shape data that is used for the part.

Package Name
Specify the package data that is used for the part.

Polarized
Specify whether or not the part has polarity.  A part is considered to have polarity when the 
part is not symmetrical, electrically and/or physically.  If the part has no polarity, then a 
placement of 180 degrees opposite to the specified angle does not affect the board.

Direction
Specify how the part is oriented in the package compared to the direction the part was 
created in the shape library and zero orientation. 

This is used by the placing machines for vision processing and placement.

Barcode Label
Specify the barcode label for the feeder verification check if Fujitrax Verifier is used.

Part Comment
Enter a part comment.

Name Comments Chg

Part Shape X

Package Name X

Polarized X

Direction This is a vision related setting. O

Barcode Label This setting is required when using Fujitrax 
Verifier.  If Fujitrax Verifier is not used, then this 
setting is not required.

X

Part Comment X

Allow Multiple Slots Used during line balancing and optimization only. X

Limit Target Machines Used during line balancing only. X

Target Machine List Only displays if [Limit Target Machine] is “Yes”. X
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Allow Multiple Slots
Specify whether or not to allocate the same part to multiple machines and feeders during 
line balancing and optimization.

Note: The setting [Feeder Duplication] (NXT) has priority in optimization over [Allow Multiple Slots].

Limit Target Machines
Specify whether or not to limit this part to specific machines.  If this setting is “No”, then the 
part can be allocated to any machine that can place the part.  If this setting is “Yes”, then 
the part can only be allocated to one of the machines specified in the [Target Machine List].  
The [Target Machine List] only displays if this setting is “Yes”.

Target Machine List
When the part is to be limited to specific machines only by changing the [Limit Target 
Machines] setting to “Yes”, then this setting is displayed and then machines to which the 
part can be allocated to must be specified here.  Click the value cell for this setting twice 
and a [Select Machine Model] dialog box is displayed.  Select the machines to which the 
part can be allocated and then click [OK].

Setting Description

Yes Specifies that it is possible to divide the part among 
multiple machines during line balancing.  During 
optimization it is also possible that the part will be divided 
into multiple feeders during optimization.\

No Line balancer and Optimizer do not divide the part among 
multiple machines and feeders.
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4.3 Shape Data
The following list is the part data settings used by the NXT for shape data.

4.3.1 Shape Information tab

The settings for items with an O in the “Chg” column can be changed in MEdit.  The settings 
for items with an X in this column cannot be changed in MEdit.  

Section Name Comments Chg

Body Length (X) This is a vision related setting. O

Width (Y) This is a vision related setting. O

Length Tolerance (X) This is a vision related setting. O

Width Tolerance (Y) This is a vision related setting. O

Height This is a machine control setting. O

Color This is a vision related setting. O

Lead Pitch Tolerance This is a vision related setting. O

Element Information If the part has elements, then they 
must be specified in this location.  All 
settings in this area are vision related 
settings.

O

Lead - 
Element 
Information

Side This is a vision related setting. O

Position X This is a vision related setting. O

Position Y This is a vision related setting. O

Quantity This is a vision related setting. O

Pitch This is a vision related setting. O

Width This is a vision related setting. O

Width Tolerance This is a vision related setting. O

Length This is a vision related setting. O

Length Tolerance This is a vision related setting. O

Center Tolerance This is a vision related setting. O

Result This is a vision related setting. O

P_pattern This is a vision related setting. O
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4.3.2 Shape Process tab 

Section Name Comments Chg

Body Location Pin Length This is a machine control setting. O

Lead Check Point This is a vision related setting. O

Quantity Check Limit This is a vision related setting. O

Lead Brightness This is a vision related setting. O

Process - 
Nozzle

Minimum Diameter This is a machine control setting. O

Maximum Diameter This is a machine control setting. O

Name This is a machine control setting. O

Process - 
Pick

Do Auto Offset This is a machine control setting. O

Offset X This is a machine control setting. O

Offset Y This is a machine control setting. O

Offset Z This is a machine control setting. O

Tray Pick Offset Z This is a machine control setting. O

Soft Pick Speed This is a machine control setting. O

Enable Pressure Sensor This is a machine control setting. O

Offset Q This is a machine control setting. X

Process - 
Pick - 
Tolerance 
Check

Tolerance X This is a machine control setting. O

Tolerance Y This is a machine control setting. O

Tolerance Q This is a machine control setting. O

Process - 
Pick - 
MTU

Shuttle Speed This is a machine control setting. O

Magazine Speed This is a machine control setting. O

Process - 
Place

Offset Z This is a machine control setting. O

Pressure This is a machine control setting. O

Transport Speed This is a machine control setting. O

Transport Speed Z This is a machine control setting. O

Transport Speed Q This is a machine control setting. O

Soft Place Speed This is a machine control setting. O

Place Motion Selection This is a machine control setting. O

Placing Thrust Pressure This is a machine control setting. O

Placement Wait Time This is a machine control setting. O
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The settings for items with an O in the “Chg” column can be changed in MEdit.  The settings 
for items with an X in this column cannot be changed in MEdit.  NA means that this part data 
setting is not set at the machine so any changes here are not reflected at the machine.

Entering part dimensions and positions
The dimensions and positions for the part are entered in the X- and Y-directions when 
viewed from above.

Process - 
Error

Alt Feeder Trigger This setting is not used from the part 
data.  This setting for the NXT is set 
through  Accessory Software.

NA

Dump Position This is a machine control setting. O

Forcing Recovery Times 
As 0

This is a machine control setting. O

Recovery Times This is a machine control setting. O

Vision Vision Type Refer to Vision Type Details for 
information.

O

Vision Area Offset X This is an OF head setting. X

Vision Area Offset Y This is an OF head setting. X

Pin Check Pin Check Mode This is a vision related setting. X

Is Bottom Mark Present This is a vision related setting. X

Is Bump Present This is a vision related setting. X

Upper Left X This is a vision related setting. X

Upper Left Y This is a vision related setting. X

Lower Right X This is a vision related setting. X

Lower Right Y This is a vision related setting. X

Coplanarity Not Supported Yet X

Section Name Comments Chg

FUJI

Y

X

XY-coordinates (part upper surface)

+

+
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4.3.3 Shape information details
Body
Length (X)
Specify X-direction length of the part's body size.

Width (Y)
Specify Y-direction length of the part's body size.

Length Tolerance (X)
Specify the part's X-direction length tolerance.

Width Tolerance (Y)
Specify the part's Y-direction length tolerance.

Height
Specify the part's height.

Height Tolerance
Specify the part's height tolerance.

Color
For the NXT, this is used for vision processing of parts.  Parts that are using the body 
detection vision types must have the color specified as “White”.  

The vision type that this setting must be “White” are: 60, 61, 62, 63, 65, 71, 74, 80, 153, 
160, and 252.  

Parts using these vision type that do not appear “white” in the images (the body is completly 
black with no leads), cannot be vision processed using these vision types.

Lead
Pitch Tolerance
It is the tolerance allowed for the deviation from the pitch as a percentage of the lead pitch 
length. If no setting is made here, processing is carried out using a default value of 30%.

Element Information
Set element related data.  An element is a group of leads on the same side of a part which 
have the same length, width, and pitch.  As there may be several elements on a part, 
numbers are assigned to the elements for identification purposes.

Double-click the data cell for this field and the [Element Information] dialog box displays. 
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Position X, Y
This expresses the X- and Y-coordinates from the center of the part to the point on the side 
of the part that is central with the element.  (Refer to the figure below)

Side
Specify the side on which the element is located.  Side numbers should always be assigned 
as shown in the above figure (at direction 0).

P_pattern
Specify how the leads appear to the vision processing system.  Select the P Pattern from 
the choices that matches the lead image.

Refer to section 3.5 P_pattern Details for details on settings for this item.  The table below 
lists the common P_pattern settings for the NXT.

(X-position, Y-position)

(0, 0)
Body

Lead element group

1

4 3

2

Side 0

Side 1

Side 2

Side 3

Part Type P Pattern 
Number

SOIC, SOT 4

QFP (leads on 4 sides) 14

SOJ 4

PLCC 12

BGA (White body) 1

BGA (Black body) 2
38 NXT Programming Manual



QD004-05 4. Part Data Settings
Result
Specify the type of check which will be performed on the leads in the element. Normally, 
this is set to [Inspect]. The check items are described below. 

Quantity
Specify the number of leads in the element.

Pitch
Specify the pitch of the element leads.

Width
Specify the width of element leads. 

Group Setting Description

Vision 
Processing 
Options

Inspect Specifies the usual vision processing inspection 
without special checks.  This setting is specified for 
standard parts which do not have special shapes.

Don't inspect The element is not inspected.

Virtual lead This setting is used to define virtual leads.  When the 
part is inspected, the vision processing system 
verifies that there are no leads in the virtual lead area.  
This function is useful for polarity checks.

Matrix Use this for BGAs and flip chips.  Because the leads 
are defined as a two dimensional array on these 
parts, two records are necessary to define one 
element.  Result is set to “Inspect” in the first element 
and in the second element result is set to "Matrix." 
The "Matrix" setting alerts the vision processing 
system that this is a grid-type part and that two 
consecutive element records describe one element.

Check 
Items

No length 
tolerance check

Select this item to disable the lead length tolerance 
check.  This setting is used when there is a wide 
variation in the length of the leads.

No width 
tolerance check

Select this item to disable the lead width tolerance 
check.  This setting is used when there is a wide 
variation in the width of the leads.

First pin check Use this to check that there is no lead to the left of the 
very first lead detected (leads are inspected from left 
to right). 

Last pin check Select this item to enable the last pin check function.  
In left to right vision processing of leads, this function 
verifies that there is no lead to the right of the last 
detected lead.  In top to bottom vision processing of 
leads, it verifies that there is no lead below the last 
detected lead.

No center 
length tolerance 
check

Not supported

No center width 
tolerance check

Not supported
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Width Tolerance
Specify the width tolerance of element leads.

Length
Specify the length of the element leads. 

Length Tolerance
Specify the length tolerance of the element leads.

Center Tolerance
Specify the bend tolerance for the element leads.

4.3.4 Shape process details
Body
Location Pin Length
Specify the length in mm of any locating pins on the shape if they are present.  This setting 
is especially required if using the insertion pressure function.

Lead
Check Point
Specify the point on the leads (measured from the end of the lead) that is checked.  If 0 is 
specified, the check occurs at the lead's 30% position.  The following settings represent 
general guidelines for various parts.  

Quantity Check Limit
Specify the number of leads on leaded parts which must be detected for the part to pass 
inspection.  If this is set to 100%, all the leads must be detected; if set to 90%, 90% of the 
leads must be detected.  This is normally set to 100%.

Lead Brightness
This sets the brightness level for leads (bumps) that is used when automatic determination 
of lead brightness is difficult.  Correspondingly larger values should be specified for brighter 
leads.  When set to 0, brightness is determined automatically.

Process - Nozzle
Minimum Diameter
Specify the minimum nozzle diameter which can be used to pick up the part with the shape.

Maximum Diameter
Specify the maximum nozzle diameter which can be used to pick up the part with the shape.

Part Type Setting

SOP / QPF 10 to 90% (standard setting: 30%) 

PLCCs / SOJ 50 to 70% (standard setting: 60%)

BGA / Flip Chip 50%
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Name
Set this parameter for special nozzles.  Although a nozzle is normally identified by the size 
of its circular pickup area, a name is specified for special non-circular nozzles.

Process - Pick
Do Auto Offset
Specify whether automatic compensation is performed for pick-up offsets.  When No is 
specified, the center of the part is used as the part pick-up position.  However, pick-up at 
the part center may not be possible for various reasons.  To counter this, the amount of 
offset is calculated by vision processing and this information can be fed back to the pick-up 
position so that the part can be picked up at its center.

If parts are not being correctly picked up at their centers and "Do Auto Offset" is set to Yes, 
the offset between the nozzle center and the part center is calculated and fed back to the 
control software so that subsequent parts can be correctly picked at their centers. 

Offset X, Y
Normally, parts are picked up at the center of their bodies. However, for some odd shaped 
parts this is not possible.  If necessary, specify an offset from the center of the packaging 
cavity to the pickup point on the body for the part to pick-up such parts.  If 0 is entered, the 
pickup point is the center of the packaging cavity.  The value specified in Offset X, Y are the 
point at which the part is picked up, and the center of the camera field of view is aligned 
with the center of the nozzle during vision processing.

Offset Z
Specify an up or down offset for the pickup position of the part in a feeder cavity.

Tray Pick Offset Z
Specify an up or down offset for the pick-up point of the part in a tray cavity.

Soft Pick Speed
Specify the percentage of the maximum possible Z-axis speed at which the part is carried 
after pick-up.

Enable Pressure Sensor
This specifies whether or not the part using the shape data is picked with 220 gf when using 
the H01 head.  If set to "Yes" the part is picked using pressure conrol, while if the setting is 
"No" the pressure control is not used when the part is picked.  This setting is only applicable 
for the H01 head on the NXT.  This setting has priority over soft pick-up settings.

Tolerance X / Tolerance Y
This sets the tolerance for misalignment of the nozzle center and part center.  The machine 
rejects the part if these tolerances are exceeded.  

Tolerance Q
Specify the tolerance for misalignments between the nozzle and part centers in the Q 
direction.  Generally, 30 degrees is entered for Tolerance Q.  For parts with a body 
dimension larger than 20 mm, input 15 degrees.

Shuttle Speed
Specify the shuttle speed at which an MTU tray is loaded into the machine.  A setting of 4 
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is the fastest speed, while a setting of 1 is the slowest.

Magazine Speed
Specify the acceleration/deceleration rate used when raising and lowering trays in the MTU.

Process - Place
Offset Z
Specify an offset value for part placement height.

Pressure
Specify the force to be used to place a part using this shape when placed using a H01 head.  
The valid range for the NXT is 220 gf to 1020 gf.  If "0" is specified here, the part is placed 
using no pressure control.  When settings less than the minimum are specified, the part is 
placed using the minimum pressure.  When settings more than maximum are specified, the 
part is placed using the maximum pressure.  This setting is only applicable for H01 heads 
on the NXT.  This setting has priority over soft placement settings.

Transport Speed
Specify, as a percentage of the maximum transport speed, the speed at which the placing 
head carries the part from the pick-up position to the placing position.

Transport Speed Z
Specify the maximum speed at which the nozzle moves along the Z axis while transporting 
a part (i.e., from pickup to placement).

Transport Speed Q
Specify the maximum speed at which the nozzle rotates while transporting a part (I.e., from 
pickup to placement).

Soft Place Speed
This sets the Z-axis transport speed. This is the speed at which the part is lowered to the 
surface of the board.  If this speed is too high, the part will spring back when the nozzle 
retracts, resulting in a misalignment.
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Place Motion Selection (from NXT V3.10)
Specify the pressure (torque) method to be used for insertation pressure.  This can be used 
with the H01 head.  In order to use this function, Fuji Flexa V2.2.0 or higher must be used.  
The default setting of "0" disables this function.  Enter a value between 1 to 4 to enable 
insertion pressure placing.  If 5 is entered, insertion pressure is not used but if a claw is used 
to pick the part, the margin between the top of the part and the ledge on the claw will be 0 
mm (normally there is a clearance of 0.5 mm).

Note: Always ensure to use backup pins underneath the panel when using insertion pressure.
Note: When an insertion error occurs and the user then clears the error, the machine determines that the part 

has been placed and proceeds to the next placement sequence when production is resumed.  
(Recovery is not performed)

Placing Thrust Pressure
Specify the force between 39.2 N to 98 N to be used to insert the part in newtons when 
insertion pressure is to be used (a setting of 1 to 4 is set for [Place Motion Selection]).  

Placement Wait Time
Specify the time that the axis stops at the lower Z-axis limit for the placement.  If a value 
shorter than the default time specified for the head type is specified, then the time specified 
in this setting is ignored and the time for the head type is used instead.   

Process - Error
Alt Feeder Trigger
This setting is not used from the part data, but is set for the NXT through Accessory 
Software.

Dump Position
Specify the location where parts are dumped when an error occurs.

Setting Description

0 Insertion pressure is not used and the part is picked up and 
placed normally.

1 to 4 Any setting in this range is treated the same.  Insertion pressure 
is used for placement.  The part is picked up normally and during 
placement, the torque amount specified in [Placing Thrust 
Pressure] is used.  If the torque is not reached in the proper 
placing height range, an error occurs and the part is not placed.   
(Operation is different for these settings for older machines.  In 
order to preserve compatibility with older machines, this is used 
no matter what setting is specified.)

5 Insertion pressure is not used and the part is picked up and 
placed normally.

Setting Description

Conveyor Parts are dumped on the reject parts conveyor.

Box Parts are dumped into the reject parts box. 

Tray This setting is not supported for the NXT.
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Forcing Recovery Times As 0 (from NXT V3.10)
Specify whether to force the number of recovery times to be zero (0) or to use the recovery 
times set in the shape/machine data.  In order to use this function, Fuji Flexa V2.2.0 or 
higher must be used.  

Recovery Times
Specify the number of times a recovery is attempted when an error occurs.  If no setting is 
specified here, the Recovery Count value in the configuration data is used.

Vision - Vision Type
Refer to section 3.6 Vision Type Details for details on settings for this item.

Setting Description

Yes The recovery times for parts using this shape data is 
zero (0) no matter what is set in the other recovery 
settings.

No The recovery times specified in the shape data is 
used.  However, if the recovery times setting in the 
shape data is zero, then the machine configuration 
recovery times setting is used.
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Process - Pin Check
Pin Check Mode
Specify the type of check to be performed to check the direction of the part.  The checks 
“Bottom Mark” and “Bump” are supported on the NXT.  If a mode other than those two are 
specified, then the NXT ignores the pin check modes settings and a direction check is not 
performed.  If the part matches the specified conditions, then the part direction is 
considered to be correct and normal vision processing is performed.  If the part does not 
match the specified conditions, then the direction is considered to be incorrect and an error 
occurs.

Is Bottom Mark Present
This setting only displays if “Bottom Mark” is specified for the pin check.  Specify whether 
or not a bottom mark should be present in the specified area for orientation to be judged as 
being correct.

Is Bump Present
This setting only displays if “Bump” is specified for the pin check.  Specify whether or not a 
bump should be present in the specified area for orientation to be judged as being correct.

Upper Left X
Specify the upper left X-coordinate of the check range in millimeters.  The reference point 
is the center of the body with the part oriented in the zero direction.

Upper Left Y
Specify the upper left Y-coordinate of the check range in millimeters.  The reference point 
is the center of the body with the part oriented in the zero direction.

Lower Right X
Specify the lower right X-coordinate of the check range in millimeters.  The reference point 
is the center of the body with the part oriented in the zero direction.

Lower Right Y
Specify the lower right Y-coordinate of the check range in millimeters.  The reference point 
is the center of the body with the part oriented in the zero direction.

Setting Description

Bottom 
Mark

This is used to check for the presence or absence of 
a mark on the bottom of a part in a specified location.  
This check can be performed for all vision types.

Bump This is used to check for the presence or absence of 
a bump (ball lead) on the bottom of a part in a 
specified location.  This check can only be 
performed for vision types that are for parts with 
bumps. 
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4.4 Package Data
The following list is the part data settings used by the NXT for package data.

4.4.1 Package Information tab

The settings for items with an O in the “Chg” column can be changed in MEdit.  The settings 
for items with an X in this column cannot be changed in MEdit. 

4.4.2 Package Process tab 

The settings for items with an O in the “Chg” column can be changed in MEdit.  The settings 
for items with an X in this column cannot be changed in MEdit.  

Package 
Type

Name Comments Chg

All Packaging Type This is a machine control setting. X

Tape Tape Width This is a machine control setting. X

Feed Pitch This is a machine control setting. X

Stick Tape Width This is a machine control setting. X

Tape Depth This is a machine control setting. X

Tray Tray Length (X) This is a machine control setting. O

Tray Width (Y) This is a machine control setting. O

Tray Thickness This is a machine control setting. O

First Pick Position X This is a machine control setting. O

First Pick Position Y This is a machine control setting. O

Column Pitch This is a machine control setting. O

Row Pitch This is a machine control setting. O

Column Quantity This is a machine control setting. X

Row Quantity This is a machine control setting. X

Package 
Type

Name Comments Chg

Tape All settings NXT does not use any of the package 
process settings available for tape.

X

Tray Tray Type Some tray types cannot be used. O

Tray Cavity 
Information

This is a machine control setting. O
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4.4.3 Package information details
Tape
Tape Width
Specify the width of the tape.

Feed Pitch
Specify the distance in millimeters from one cavity center to the next cavity center.

Stick
Tape Width
Specify the width of the stick feeder.  Select “16mm” for the 1S and 1L type stick feeders 
(used for 18 mm wide or less sticks).  Select “32mm” for the 2S and 2L type stick feeders 
(used for 36 mm wide or less sticks).

Tape Depth
Set this to “0”.  This value is fixed.

Tray
Tray Length (X)
Specify the tray size in the X-dimension.

Tray Width (Y)
Specify the tray size in the Y-dimension.

Tray Thickness
Specify the tray thickness.

First Pickup Position X
Specify the X-position at which the machine should pick up the first part from the lower right 
corner of the tray.

First Pickup Position Y
Specify the Y-position at which the machine should pick up the first part from the lower right 
corner of the tray.

Column Pitch
Specify the pitch between the columns for the tray.

Row Pitch
Specify the pitch between the rows for the tray.

Column Quantity
Specify the number of columns for the tray.

Row Quantity
Specify the number of rows for the tray.
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4.4.4 Package process details
Tape
None of the process settings that display when tape packaging is selected are used by the 
NXT.

Tray
Tray Type
Specify the type of tray being used.  

Tray Cavity Information
Specify the cavity information (I.e. which cavities have parts and which do not) for trays.

Setting Description

Matrix-Dump Not yet supported.

No Matrix-Dump Cannot be used for the NXT

No Matrix Automatic discharge of the tray is not performed. Aluminum or 
other customer-specific trays that are heavier than normal 
cannot be lifted by the remover's vacuum pad. Instead, this 
mode is selected and the tray is changed by hand. If the 
machine fails to pick-up a part, it will attempt to pick up the part 
from the same position the specified number of recovery times. 
If pick-up is still unsuccessful, the machine proceeds to pick up 
parts from the next pick-up position.

Ref Cavity Info-Dump Not supported yet.

Ref Cavity Info Specify this item to have settings made at Tray Cavity 
Information used for pick-up information. The tray is removed 
by hand (as is the case when "No Matrix" is selected), when 
parts run out.
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4.5 P_pattern Details
The p_pattern specifies the way the lead appears to the vision processing system and how 
the processing of the lead information for the part is to be performed.  In addition, it is 
necessary to be aware that the placing position is affected by the specified p_pattern.

4.5.1 P_patterns used for the NXT
The following p_patterns are valid for use on the NXT with the frontlight system.

P_
patte

rn

Example 
Part

Details Lead 
Appearan

ce

1 Bump parts White body parts

2 Bump parts 
Column 
parts

Black body parts

4 SOIC Lead tip and width detection is performed.  
The results are used for positioning 
information.  Lead length is not used for 
positioning information with p_pattern types 
12 and 14.

SOJ The lead ends do not display well, but lead 
length is used for acquiring position 
information.  Lead length is not used for 
acquiring positioning information with 
p_pattern type 12.

6 LCC Leads point into the body and the lead tips 
and width are detected.  These results are 
used for positioning information. 

12 PLCC Because the lead ends do not display well, 
lead width only is used for acquiring position 
information.  In some cases, processing is 
more stable when using p_pattern type 14.

14 QFP Lead tip and width detection is performed.  
Because the lead width direction positioning is 
only required for determining the positioning, 
only the lead width direction results are used 
for positioning information.

16 LCC Leads extend into the body and the lead tips 
and width are detected.  These results are 
used for positioning information.  Because the 
lead width direction positioning is only 
required for determining the positioning, only 
the lead width direction results are used for 
positioning information.
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4.5.2 P_patterns not supported by the NXT
The following p_patterns are not valid for the NXT due to background conditions and/or the 
use of backlighting.

P_
patte

rn

Example 
Part

Details Lead 
Appearan

ce

24 SOJ Used only with a white background.  Lead tip 
and width detection is performed. The results 
are used for positioning information.  Lead 
length is not used for positioning information 
with p_pattern type 34.

34 PLCC Used only with a white background.  Lead tip 
and width detection is performed.  Because 
the lead width direction positioning is only 
required for determining the positioning, only 
the lead width direction results are used for 
positioning information.

3 SOIC Used only with backlighting.  Lead tip and 
width detection is performed.  The results are 
used for positioning information.  Lead length 
is not used for positioning information with 
p_pattern types 11 and 13.

SOT Used only with backlighting.  Lead tip and 
width detection is performed.  The results are 
used for positioning information.  Lead length 
is not used for positioning information with 
p_pattern types 11 and 13.

5 PLCC 
Socket

Used only with backlighting.  The leads point 
towards the inside of the body.  Lead tip and 
width detection is performed. The results are 
used for positioning information.

11 TAB Used only with backlighting.  Because the 
lead tip and base are both connected to the 
body, only the lead width is use for positioning 
information.

13 QFP Used only with backlighting.  Lead tip and 
width detection is performed.  Because the 
lead width direction positioning is only 
required for determining the positioning, only 
the lead width direction results are used for 
positioning information.
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4.5.3 P_pattern explanations
P_pattern diagram explanation

P_pattern 1, 2

Because the lead and body boundary is clearly defined, all four sides of the leads are 
checked and the results are used to determine the part positioning.

• Type 1:  The leads appear black and the outside circumference is white.

• Type 2:  The leads appear white and the outside circumference is black

These are primarily used for parts with bumps.

Example Target Parts
Type 1:  White body bumped parts processed with frontlighting.

Type 2:  Black body bumped parts or CCGAs processed with frontlighting.

NXTVPP012E

P_pattern diagram displayed in the host system 

Checked position caliper not used to determine positioning*1 

Lead 

Body 

Checked position calipers used to determine positioning*1 

       :Entered element position        :Defined element direction 

Type 7 Type 8 

*1  The caliper is a vision processing tool used for detecting the boundary between light and dark. 

NXTVPP013E

 

       :Defined element direction 

Type 1 Type 2 

       :Entered element position 
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P_pattern 3, 4

The leads extend out from the body of the part and are attached to the body at the base of 
the lead.  Due to this, the base cannot be checked with a caliper.  The lead tips and widths 
are checked and the results are used to determine the part positioning.

• Type 3:   The lead appears black and the outside circumference is white.

• Type 4:   The lead appears white and the outside circumference is black.

These are primarily used for parts with leads on one side or two opposing sides.

With parts that have leads on two perpendicular sides or more, the lead width direction is 
only required for determining the positioning, therefore it is recommended to select a 
different p_pattern (type: 11, 12, 13, 14) that matches the processing conditions.

Example Target Parts
Type 3:  SOP parts processed with backlighting.

Type 4:  Black background and body SOP/SOJ parts processed with frontlighting.

NXTVPP014E

 

       :Entered element position        :Defined element direction 

Type 3 Type 4 
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P_pattern 5, 6

The leads point towards the inside of the body of the part (opposite from types 3 and 4) and 
are attached to the body at the base of the lead.  Due to this, the base cannot be checked 
with a caliper.  The lead tips and widths are checked and the results are used to determine 
the part positioning.

• Type 5:   The lead appears black and the outside circumference is white.

• Type 6:   The lead appears white and the outside circumference is black.

These are primarily used for parts with leads on one side or two opposing sides.

With parts that have leads on two perpendicular sides or more, the lead width direction is 
only required for determining the positioning, therefore it is recommended to select a 
different p_pattern (type: 11, 12, 15, 16) that matches the processing conditions.

Example Target Parts
Type 5:  PLCC socket parts processed with backlighting.

Type 6:  Parts with leads pointing towards inside of the body and has a black background 
and body and is processed with frontlighting.

NXTVPP015E

 

       :Entered element position        :Defined element direction 

Type 6 Type 5 
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P_pattern 11, 12

These are used for parts with leads that are attached to the body at both ends of the leads 
and whose lead detection is not stable.  The lead widths are checked and the results are 
used to determine the part positioning.

• Type 11:   The lead appears black and the outside circumference is white.

• Type 12:   The lead appears white and the outside circumference is black.

Except for parts using vision type 151 and picked up by a mechanical chuck in the Y-
direction, these p_patterns can only be used for parts that have leads on two perpendicular 
sides or more.  However, if it is possible to detect either end of the lead in a stable manner, 
it is recommended to select a different p_pattern (type: 13, 14, 15, 16) that matches the 
processing conditions. 

Furthermore, the information for the part positioning using the lead length is not acquired 
so these types cannot be used for parts with leads on one side or two opposing sides only.

Example Target Parts
Type 11:  TAB parts processed with backlighting.

Type 12:  Parts with lead tips that poorly reflect using vision type 151 and a mechanical 
chuck to pick the part in the Y-direction processed with frontlighting.

NXTVPP016E

 

       :Entered element position        :Defined element direction 

Type 11 Type 12 
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P_pattern 13, 14

Basically, these are the same as p_pattern types 3 and 4.  The major difference is that with 
these p_patterns, the outward pointing lead tip is not used for determining the part 
positioning.  The lead width detection results only are used to determine the part 
positioning.  The lead tip detection results are used only as reference data for internal vision 
processing items.

• Type 13:   The lead appears black and the outside circumference is white.

• Type 14:   The lead appears white and the outside circumference is black.

It is only possible to use this for parts that have leads that are to be detected on two 
perpendicular sides or more.

Furthermore, the information for the part positioning using the lead length is not acquired 
so these types cannot be used for parts with leads on one side or two opposing sides only.

Example Target Parts
Type 13:  QFP parts processed with backlighting.

Type 14:  Black background and body parts (e.g., QFP) processed with frontlighting.

NXTVPP017E

 

       :Entered element position        :Defined element direction 

Type 13 Type 14 
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P_pattern 15, 16

Basically, these are the same as p_pattern types 5 and 6.  The major difference is that with 
these p_patterns, the inward pointing lead tip is not used for determining the part 
positioning.  The lead width detection results only are used to determine the part 
positioning.  The lead tip detection results are used only as reference data for internal vision 
processing items.

• Type 15:   The lead appears black and the outside circumference is white.

• Type 16:   The lead appears white and the outside circumference is black.

It is only possible to use this for parts that have leads that are to be detected on two 
perpendicular sides or more.

Furthermore, the information for the part positioning using the lead length is not acquired 
so these types cannot be used for parts with leads on one side or two opposing sides only.

Example Target Parts
Type 15:Currently no example target part exists.

Type 16:Black background and body parts with orthogonal leads in the body (e.g., LCC) 
processed with frontlighting.

NXTVPP018E

 

       :Entered element position        :Defined element direction 

Type 16 Type 15 
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P_pattern 23, 24

These cannot be used on the NXT.  The lead tip and width are detected and the results are 
used to determine the part position similar to p_pattern types 3 and 4.  The major difference 
is that with these p_patterns, the color of the points on the lead at which the lead tip and 
lead width are detected are opposite.

• Type 23:   The lead tip appears white, while the lead body appears black.  The 
lead tip half of the outside circumference is black, while the body half is white.

• Type 24:   The lead tip appears black, while the lead body appears white.  The 
lead tip half of the outside circumference is white, while the body half is black.

These are primarily used for parts with J-leads on one side or two opposing sides.

With parts that have J-leads on two perpendicular sides or more, the lead width direction is 
only required for determining the positioning, therefore it is recommended to select a 
different p_pattern (type: 33, 34) that matches the processing conditions.

Example Target Parts
Type 23:  Currently no example target part exists.

Type 24:  SOJ parts processed with frontlighting with a white background.

NXTVPP019E

 

       :Entered element position        :Defined element direction 

Type 23 Type 24 
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P_pattern 33, 34

These cannot be used on the NXT.  Basically, these types are the same as the types 23 
and 24.  The major difference is that with these p_patterns, the lead tip is not used for 
determining the part positioning.  The lead width detection results only are used to 
determine the part positioning.  The lead tip detection results are used only as reference 
data for internal vision processing items.

• Type 33:   The lead tip appears white, while the lead body appears black.  The 
lead tip half of the outside circumference is black, while the body half is white.

• Type 34:   The lead tip appears black, while the lead body appears white.  The 
lead tip half of the outside circumference is white, while the body half is black.

It is only possible to use this for parts that have leads that are to be detected on two 
perpendicular sides or more. 

Furthermore, the information for the part positioning using the lead length is not acquired 
so these types cannot be used for parts with leads on one side or two opposing sides only.

Example Target Parts
Type 33:  Currently no example target part exists.

Type 34:  PLCC parts processed with frontlighting with a white background.

NXTVPP020E

 

       :Entered element position        :Defined element direction 

Type 33 Type 34 
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4.5.4 Selecting a p_pattern flowcharts
For frontlight leaded parts
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For frontlight bumped (ball leaded) or columned parts

NXTVPP022E
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For backlight leaded parts (not supported by the NXT)
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4.6 Vision Type Details
4.6.1 Part reference point

The part reference point is defined as the point on the part that is aligned with the placing 
coordinates on the panel when the part is placed.

Body center
The center is taken from the outer-most points of the body; top, bottom, left, and right. 

Part center
The part center is defined as follows.

• Part center of non-leaded parts

The part center is taken from the outer-most points; top, bottom, left, and right.

• Part center of parts with leads (ball grids)

The part center is calculated from the coordinates of the lead ends or from the center 
coordinates of the ball grid taken from the outer-most points; top, bottom, left, and right.  
The point of intersection of the center line from the outer-most points top to bottom and the 
center line from the outer-most points left to right yields the part center.  However, if there 
are leads or a ball grid on only one side, a theoretical part center is defined based on the 
part data.

The following combinations are possible based on the lead positions.

Part

Placing coordinates (X, Y)

Panel

Reference point

Match
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• Leads on only one side

• Leads on two opposite sides

• Leads on two adjacent sides

• Leads on three sides

• Leads on four sides

The center moves depending on the lead positions, lead lengths, and lead widths.

Note: If there are leads on three sides, the theoretical part center and the calculated part center will differ as 
shown in the following example.

For parts with leads on three sides, the part center is defined as the point of intersection of 
the center line from the outer-most points top to bottom and the center line from the outer-
most points left to right.  As a result, the part center required for placement differs from the 
actual placing position.

                                               Ball grid body center and part center

Calculated part center

Theoretical part center

Part reference point: body center Part reference point: part center
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4.6.2 NXT vision types
This section provides a list of the vision types for the NXT and an explanation of the 
processing method used for each type.  It is possible to use older vision types for other Fuji 
machines in some cases.  When making part data, if the parts are to be shared between 
the NXT and other Fuji machines, use the old vision types in the “generic” section and enter 
overrides for the NXT vision type when necessary.  Refer to 4.7 "Compatibility with Existing 
Part Data" for details.  

Select the appropriate vision type from the following list of algorithms.

Vision 
Type

Part Types Note

60 Rectangular chips

61 Tantalum spragues

62 Resistor networks, MELFs

63 Tantalum spragues Polarity check 
performed

65 Aluminum electrolytic capacitors

70 (75) Power transistors

71 Trimmer resisters, trimmer capacitors

72 HEMT Supplied at 0 degrees

73 HEMT Supplied at 45 degrees

74 Trimmer resisters, trimmer capacitors Polarity check 
performed

80 Round shaped parts (no polarity)

123 (128) IC-type leaded parts Supports multiframe

124 (129) J-leaded parts

140 (145) Flip-chips (see note)

141 (146) White bodied parts with irregular bump 
patterns (see note)

Under development

142 (147) Black bodied parts with irregular bump 
patterns (see note)

Under development

143 (148) CCGA parts Supports multiframe

144 (149) LGA parts Supports multiframe

151 (156) Black connectors placed using mechanical 
chuck

152 (157) Black bodied connectors Supports multiframe

153 (158) White bodied connectors Supports multiframe

160 (165) Body detection (frontlight)
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Note: The vision types in parentheses use the part center.

170 Mechanical chuck part existence check

180 (185) Tantulams, condensers, SOT-type parts Up to 8 leads

181 Coil parts 2 Leads at 45 degrees

230 (235) Black bodied BGAs Supports multiframe

231 (236) White bodied BGAs Supports multiframe

233 (238) Black bodied CSPs

234 (239) White bodied CSPs

240 VPDplus (MPA) From NXT V3.0.  
Supports multiframe

252 White bodied parts Supports multiframe

Vision 
Type

Part Types Note
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4. Part Data Settings QD004-05
Vision type number details
The following section provides an explanation of the processing method for each vision 
type.

Vision Type 60    Rectangular Chips
Enter the body size in part data.  There is no need to enter element information.  The 
reference point for the part is the part center.  

Vision Type 61    Tantalum Spragues
Vision Type 63    Tantalum Spragues (polarity check performed)
Enter the body size in part data.  There is no need to enter element information.  The 
projection of the tantalum sprague must be included in the body size.  The reference point 
for the part is the part center.  To perform a polarity check, the direction of supply must be 
correctly specified in part data.

Rectangular chip

Body size X

Direction  0 deg 90 deg

Supply direction

Body size 

Y

Tantalum sprague

Direction  0 deg 90 deg     180 deg     270 deg

Body size X

Body

size Y

Supply direction
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QD004-05 4. Part Data Settings
Vision Type 62    Resistors networks, MELFs 
Enter the body size in part data.  There is no need to enter element information.  The 
reference point for the part is the part center. 

Vision Type 65    Aluminum electrolytic capacitors
Enter the body size in part data.  There is no need to enter element information.  Be sure 
to include projections such as leads in the body size.  The reference point for the part is the 
part center.

Resistor networks

Glass tube diodes MELF

Direction  0 deg 90 deg

Body size X

Body size X

Body size X

Body

size

Y

Body

size

Y

Supply direction

Body

size

Y

Body size X

Body

size

Y

Aluminum electrolytic capacitor

Direction  0 deg 90 deg

Supply direction
Body size X

Body

size

 Y
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4. Part Data Settings QD004-05
Vision Type 70 (75) Power transistors
It is necessary to enter the body size and element information in part data.  The reference 
point is the body center with vision type 70, while the reference point is the part center with 
vision type 75.  Create separate element data for leads of different length and width.  If the 
leads have a large cuts at the corners then it is necessary to select the [Don’t inspect] option 
for the [Result] group for that element.

Power transistor

Element 1

Direction   0 deg        90 deg     180 deg      270 deg          

Element

Body

size

Y

Body size X

Element 2

Element 3

Supply direction

Note: Create separate 

element data for leads

of different length and

width.

Element 4
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QD004-05 4. Part Data Settings
Vision Type 71    Trimmer resistors, trimmer capacitors
Enter the body size in part data.  There is no need to enter element information.  Note that 
projections such as leads are included in the body size.  The reference point for the part is 
the part center.

Vision Type 72    HEMT (Supplied at 0 degrees)
Vision Type 73    HEMT (Supplied at 45 degrees)
It is necessary to enter the body size and element information in part data.  The reference 
point for the part is the part center.  If the tip of a lead is not square by design then this 
information must be set in part data so that it is not detected as a defect.  Note that polarity 
inspection cannot be performed.

Vision Type 74    Trimmer resistors, trimmer capacitors (Polarity check performed)
It is necessary to enter the body size and element information in part data.

Direction    0 deg    90 deg  180 deg  270 deg

Supply direction

Body size X
Body size X

Body

size

Y

Body

size

Y

Trimmer resistors Trimmer capacitors

Element

Direction 0 deg 90 deg 180 deg 270 deg

Vision type: 72

Vision type: 73

Supply direction

Supply directionBody size X

Body size Y

HEMT

Direction 0 deg 90 deg 180 deg 270 deg
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4. Part Data Settings QD004-05
Enter the lead quantity (2 or 3), lead width and length, and width tolerance. 

First, the part position is determined using the vision type 71 processing method, and then, 
direction inspection is performed based on the detection of one lead.  However, the 
detected lead is not used for positioning.  The reference point for the part is the part center.

It is important to note the following points.

• Direction inspection is possible only if there are 2 or 3 leads on only one side.

• Direction inspection cannot be performed if diagonally across from the detected 
lead there is a protrusion of the same shape as the lead (Fig. 1)

• Using a two pin setting, detection of three pins of the same shape is not possible. 
(Fig. 2)

• Only enter one element into the element information.  If 2 or more elements are 
entered, an 0xD62A error (element data is incorrect) occurs when the parts are 
being registered..

Direction    0 deg    90 deg  180 deg  270 deg

Supply direction

Body size X Body size X

Body

size

Y

Body

size

Y

Trimmer resistors Trimmer capacitors

Element

2-pin 3-pin

Fig. 1 Detected lead position when performing direction inspection

Detected lead

Direction inspection is impossible if

a protrusion of the same shape as the lead exists 

diagonally across from a lead.

Fig 2. Set as 2-pin part in part data

Detected lead

2-pin          3-pin (no error occurs)
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QD004-05 4. Part Data Settings
Vision Type 80    Round shaped parts
Enter only the body size in part data.  There is no need to enter element information.  The 
reference point for the part is the part center.

Direction 0 deg

Supply direction

Body size Y

Body size X

Round shaped part
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4. Part Data Settings QD004-05
Vision Type 123 (128) IC- type leaded parts
Vision Type 124 (129) J-leaded parts
Enter the body size and element information in part data.  Due to the use of frontlighting, 
there are cases where  the acquired image may vary depending on the shape of the leads 
and the lighting conditions.  In such cases, it may be necessary to make adjustments to the 
position, length and width of the lead information in element information.  Vision types 123, 
124 use the body center while vision types 128, 129 use the part center.  

Vision Type 140 (145) Flip-chips
Enter the body size and element information in part data.  Vision type 140 uses the body 
center while vision type 145 uses the part center.

Due to the use of frontlighting, there are cases where  the image of the ball grid may vary 
depending on the shape of the leads and the lighting conditions.  In such cases, it may be 
necessary to make adjustments to the ball grid position, length and width of the lead 
information in element information.

Inspection of certain parts may not be possible due to variations in the body color and the 
and the image of the ball grid. 

SOIC

Direction  0 deg        90 degElement

Body

size

Y

Body size X

Supply direction

PLCC
Body size X

Body

size

Y

Flip chip
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QD004-05 4. Part Data Settings
Vision Type 141 (146) White bodied parts with irregular bump patterns (under 
development)
Vision Type 142 (147) Black bodied parts with irregular bump patterns (under 
development)
Select either of these vision types for bump leaded parts with irregular bump patterns.  
Enter the body size and element information in part data.  Vision types 141, 142 use the 
body center while vision types 146, 147 use the part center.

The following conditions apply to bump leads:

• There must be two or more bumps on the part.

• All bumps must be located at least the distance of the bump diameter from the 
edge of the part.

• The pitch must be equal or greater to two times the bump diameter.  However, 
for parts with only two bumps, the pitch must be greater or equal to one sixth (1/
6) of the average body size in all directions.

Vision Type 143 (148) Ceramic column grid array (CCGA) parts
Enter the body size and element information in part data.  Vision type 143 uses the body 
center while vision type 148 uses the part center.

Due to the use of frontlighting, there are cases where  the image of the ball grid may vary 
depending on the shape of the leads and the lighting conditions.  In such cases, it may be 
necessary to make adjustments to the ball grid position, length and width of the lead 
information in element information.

Vision Type 144 (149) Land grid array (LGA) parts
Enter the body size and element information in part data.  Vision type 144 uses the body 
center while vision type 149 uses the part center.

Vision Type 151 (156) Black connectors placed using a mechanical chuck
Enter the body size and element information in part data.  It is necessary to create separate 
element information for leads of different width and length.  Vision type 151 uses the body 
center while vision type 156 uses the part center.

CCGA
NXT Programming Manual 73



4. Part Data Settings QD004-05
Vision Type 152 (157) Black bodied connectors
Enter the body size and element information in part data.  It is necessary to create separate 
element information for leads of different width and length.  Vision type 152 uses the body 
center while vision type 157 uses the part center.

<Examples of parts that can be inspected>

Lead

Black portion of the part (e.g. body or coating)

<Examples of parts that cannot be inspected>

The parts cannot be correctly inspected if any metal that

reflects light similarly to leads exists within the body

of the part.
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QD004-05 4. Part Data Settings
Vision Type 153 (158) White bodied connectors
Enter the body size and element information in part data.  It is necessary to create separate 
element information for leads of different width and length.  Vision type 153 uses the body 
center while vision type 158 uses the part center.

Lead

White portion of the part (e.g. body or coating)

<Examples of parts that can be inspected>

LeadWhite portion of the part (e.g. body or coating)

The outer form of the part is used to determine the rough

positioning of the part.  Therefore inspection of the part

is not possible if the outer form of the part cannot be determined.

Black portion of the part (e.g. body or coating) Wiring

<Examples of parts that cannot be inspected>
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4. Part Data Settings QD004-05
Vision Type 160 (165) White connector body detection
Enter the body size and element information for leads or projections.  Vision type 160 uses 
the body center while vision type 165 uses the part center.  Element inspection is not 
performed if the [Result] option for that element is set to "Don’t inspect".

The body inspection points are automatically determined based on the data for leads and 
projections specified in the element information.  When detection positions cannot be 
properly determined automatically, up to two elements per side can be specified in the 
element information for the body inspection points.  To specify body detection points, 
specify the side and then enter the coordinates for the points to be inspected in [X] and [Y] 
items for the position group and enter "0" for all other items for each “detection” element in 
the element information.

Note: It is necessary to define leads in element information regardless of whether lead inspection is to be 
performed for those leads or not.

Note: When the body detection option is specified, data should be specified such that there is a minimum of 
one side where two points can be detected and a minimum of two sides where one point can be 
detected.  If there are an insufficient number of detection points, an error occurs when data is registered.

Note: If the edges of the body of a part are not clearly projected, this may result in an error or a drop in the 
placing accuracy.

Note: Correct processing cannot be performed if the nozzle protrudes over the edge of the part.
Note: If the straight line obtained from the specified detection points for the same line is not parallel nor 

perpendicular to the straight line obtained from the detection points of another side, then processing 
cannot be performed.

Vision Type 170 Mechanical chuck part existence check
Use this vision type when part recognition is not possible using any other vision type.  In the 
shape data, set the vision type to 170, specify a setting for [Lead Brightness] and specify 
the check area and select either 1 or 2 for the p_pattern in the element information.  Based 
on this data, if it is determined that the part has been picked, then the part is placed without 
performing any correction based on vision.  The part is positioned mechanically.

When vision processing is performed, the average greyscale of the area specified in the 
element data is determined.  This average is compared to the lead brightness setting and 
based on the p_pattern setting it is determined whether or not the part is present. 

If the p_pattern setting is 1 (dark) and the average greyscale value is higher than the lead 
brightness setting, it is determined that the part is present.  If the average grayscale is lower 
than the lead brightness setting, then it is determined that the part is not present. 

If the p_pattern setting is 2 (light) and the average greyscale value is lower than the lead 
brightness setting, it is determined that the part is present.  If the average grayscale is 
higher than the lead brightness setting, then it is determined that the part is not present. 

Note: Use a chuck with four claws when using this vision type.

: Points which can be used to define the part body.

: Points which cannot be used to define the part body.
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QD004-05 4. Part Data Settings
Vision Type 180 (185) SOT-type parts
Use this vision type for parts with between 2 and 6 leads where the body color is black and 
only the leads are visible during vision processing.  Enter the body size and element 
information in part data.  Vision type 180 uses the body center while vision type 185 uses 
the part center 

Note: This vision type can be used for parts with up to six leads.  Vision processing is not possible for parts 
with 7 leads or more.

Note: Vision processing maynot be performed if the lighting is unevenly reflected by leads.

SOT (3 leads) SOT (6 leads)

Direction   0 deg    90 deg  180 deg  270 deg

Element

Body size X

Body size Y

Element

Supply direction

Body size X

Body size Y
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4. Part Data Settings QD004-05
Vision Type 181 Coil parts with two leads at 45 degree angles
Use this vision type for coil parts with 2 leads that are at 45 degree angles from the x-axis 
(as shown below).  The body color is black and only the leads are visible during vision 
processing.  Enter the body size and element information in part data based on the 
information below.

Vision Type 230 (235) Black bodied BGAs
Vision Type 231 (236) White bodied BGAs
Vision Type 233 (238) Black bodied CSPs
Vision Type 234 (239) White bodied CSPs
Enter the part body size and element information in part data.   Vision types 230, 231, 233, 
and 234 use the body center while vision types 235, 236, 237, and 238 use the part center.

Due to the use of frontlighting, there are cases where  the image of the ball grid may vary 
depending on the shape of the leads and the lighting conditions.  In such cases, it may be 
necessary to make adjustments to the ball grid position, length and width of the lead 
information in element information.  The reference point for the part is the part center. 

Vision Type 252    White bodied parts
This vision type is used for those parts with a white or gold colored body, and processes 
only the part outline.

It is necessary to enter the body size in part data.  The body size should be measured from 
edge to edge.  Positioning is performed using the outer-most points on the upper and lower, 
and left and right part edges.

Coil in 0 direction Coil rotated -45 degrees

Element

Body Length (X)

Body Width (Y)

Element

Lead Length

Lead WidthSide 0

Side 3

Side 1

Side 0

NXTPRG045E

Black BGA White BGA
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QD004-05 4. Part Data Settings
4.6.3 Selecting a Vision Type flowcharts (leaded parts)
Case 1: Entire body color is black or a dark color (black, blue, green or 
yellow green)
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4. Part Data Settings QD004-05
Figure 1 Example of rectangular shaped leads Example of non-rectangular shaped lead

NXTVPP024E

The defined lead area and actual captured image is substantially

different, distinguish by the rectangular and non-rectangular lead shapes 

For example, if the center thinner leadwidth is defined, a vision processing 

will occur when using vision type 180.

Figure 2
Example of left to right symmetrical part. Top to bottom symmetrical part

NXTVPP025E

Detemine the symmetry by considering all white items 

that can be seen (lead or other metal items)

Figure 3

Examples of asymmetrical parts

NXTVPP026E

Detemine the asymmetry by considering all white 

items that can be seen (lead or other metal items)
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QD004-05 4. Part Data Settings
Case: 2 Entire body color is white or light color (white, red, orange, 
brown, yellow)
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4. Part Data Settings QD004-05
Figure 4 Parts that have leads in the white body area.

NXTVPP027E

Figure 5

Used the parts from #4. Used VPDPlus and set the lighting to "Incident" 

and exposure time to "170ms". 

NXTVPP028E

Figure 6

Poor lead shape (The leads are too short) Including parts with leads that have 

poor lead image definition. 

NXTVPP029E

Figure 7

There is no more than 1mm of body edge with no leads or other items  

NXTVPP030E

Figure 8

There should be at least one side with 2 body detection points, or there should be 

at least two sides with one body detection point each. 

(This part has 4 sides with 2 detection points each.)

NXTVPP031E
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QD004-05 4. Part Data Settings
Case 3: Black body with partial white or there is a metal part in addition 
to the lead
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4. Part Data Settings QD004-05
Figure 1 Example of rectangular shaped leads Example of non-rectangular shaped lead

NXTVPP024E

The defined lead area and actual captured image is substantially

different, distinguish by the rectangular and non-rectangular lead shapes 

For example, if the center thinner leadwidth is defined, a vision processing 

will occur when using vision type 180.

Figure 2
Example of left to right symmetrical part. Top to bottom symmetrical part

NXTVPP025E

Detemine the symmetry by considering all white items 

that can be seen (lead or other metal items)

Figure 3

Examples of asymmetrical parts

NXTVPP026E

Detemine the asymmetry by considering all white 

items that can be seen (lead or other metal items)

Figure 9
Leads are not connected to white areas  

To determine whether or not the leads and white area are 

connected, observe the part and imagine how the lead will 

be seen by the parts camera.  Refer to the picture on the left. 

The gull-wing leads made shadows around the lead bases.  

We see the leads and white area as being separated. The 

gold leads are bright and easily seen. The gull wing angle or 

lead width makes the lead base appear dark.  If VPDPlus and 

the camera stand are available, use that to acquire an image 

of the part. That is the easiest way to see how the machine

will see the part. 
NXTVPP032E
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Figure 10

For example, the size of the white area is nearly the 

same size as the body size.

The size, not the area.

NXTVPP033E

Figure 11

Distribution of the white area. There are more than two sections of white area. 

This part is like two three-pin minimolds facing each other in 

a white body. 

The leads that must be detected are the two on each left and 

right side. (The center lead has poor contrast so these leads 

should not be checked. )

However, the white area is not stable and there are some white 

blocks. These may be detected as leads and cause errors. 

NXTVPP034E

Figure 12

Example of when the white area and lead size are different and nearly same.

For these type of parts, the white area of the image can be different 

depending on the lot. Therefore, the surface of the part may appear 

bright or dark in the image.  In order to be able to correctly vision 

process in both cases, it is necessary to define three leads (the right 

top, left bottm and right bottom leads). 

In a case of the bright parts, the center of the bright area can be 

detected as one big white area.  The center will not be wrongly detected 

because when this area and the lead sizes are compared, the sizes are 

completely different. 

However, in a case of the dark parts, the vision processing system has 

problems determining the leads because 

there are apporoximately eight areas the same size and shape in the image. 

NXTVPP035E

Figure 13
Example of when lead-like shapes are in body of the part. 

NXTVPP036E
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Case 4: White body but partly black
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QD004-05 4. Part Data Settings
Figure 2
Example of left to right symmetrical part. Top to bottom symmetrical part

NXTVPP025E

Detemine the symmetry by considering all white items 

that can be seen (lead or other metal items)

Figure 3

Examples of asymmetrical parts

NXTVPP026E

Detemine the asymmetry by considering all white 

items that can be seen (lead or other metal items)

Figure 14

Examples of when the black area is surrounded by white body.

NXTVPP037E
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4. Part Data Settings QD004-05
4.7 Compatibility with Existing Part Data
4.7.1 Background

Existing Fuji machines support both backlight and frontlight systems, however, the newly 
developed NXT machines support frontlight only.  As a result, it is necessary to convert 
existing part data created for used with a backlight system to enable the part to be 
processed using a frontlight system.  The NXT machines are equipped with a feature that 
enables automatic conversion of part data created for backlight systems, however, there 
are cases whereby it is necessary to make a setting at the "Override" field in Fuji Flexa for 
the part data of certain parts.  This section provides a compatibility table for the part data of 
existing machines and the NXT machines, as well as details of limitations relating to the part 
data conversion process.

It is important to point out that when making new part data, use the old vision type and p 
patterns if the data is to be used on other Fuji machines.  If the data is never to be used on 
older Fuji machines (only NXTs are present), then use the NXT vision types and the 
frontlight p_patterns.
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QD004-05 4. Part Data Settings
4.7.2 Vision type compatibility table for the NXT 

Vision Types New P Pattern Part Type Notes

Old NXT 

10 60 Rectangular chips Select an appropriate vision 
type based on part shape.
Override required  (Note 1)65 Aluminum electrolytic capacitors

180 Tantalum capacitors

123/124/
144

Leaded parts

11 61 Tantalum spragues

12 62 Resistor networks, MELFs

13 63 Tantalum spragues
(Polarity check performed)

20 180 (Old P Pattern) +1* Tantalum capacitors, SOTs Select an appropriate vision 
type based on part shape.
Override input required  (Note 
2)

75 (Old P Pattern) +1* Power transistors

21 71 Trimmer resistors/trimmer 
capacitors

22 72 (Old P Pattern) +1* HEMT (0 degree)

23 73 (Old P Pattern) +1* HEMT (supplied at 45 degrees)

24 74 (Old P Pattern) +1* Trimmer resistors/trimmer 
capacitors
(Polarity check performed)

30 80 Round shaped parts

40 160 (Old P Pattern) +1* White body detection Select an appropriate vision 
type based on part shape.
Override required  (Note 3)60/123/

124/152/
153/180/
252

(Old P Pattern) +1* Leaded part / part outline

100 (105) 123 (128) (Old P Pattern) +1* IC-type leaded parts

120 (125) 124 (129) 24->4, 34->14*
(Conversion not  
required for others)

J-leaded parts

121 (126) 124 (129) As above J-leaded parts

122 (127) 124 (129) As above J-leaded parts

123 (128) 123 (128) As above IC-leaded parts

124 (129) 124 (129) As above J-leaded parts

130 (135) 230 (235) Conversion not  required Black bodied BGA

131 (136) 231 (236) As above White bodied BGA

140 (145) 140 (145) As above Flip-chips

141 (146) - White bodied irregular bump 
parts

Under development
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4. Part Data Settings QD004-05
Note: The p pattern is automatically converted if the old vision type is in the “generic” section.
Note: The shaded areas represent the vision types for which automatic conversion is not supported by the 

NXT machines.  All other vision types are supported and therefore require no additional data entry.

142 (147) - Black bodied irregular bump 
parts

Under development

143 (148) CCGA

144 (149) LGA

150 (155) 153 (Old P Pattern) +1* White bodied connector Select an appropriate vision 
type based on part color and 
image quality. Override 
required  (Note 4)

152 (Old P Pattern) +1* Black bodied connector

151 (156) 151 (156) Conversion not  required Mechanical chuck connectors 

152 (157) 152 (157) As above Black bodied connector

153 (158) 153 (158) As above White bodied connector

160 (165) 160 (165) As above White bodied connector 
detection

170 170 As above Mechanical chuck part presence 
check

180 (185) 180 (185) Conversion not  required Tantalum capacitors, SOTs

181 Coil parts 2 leads at 45 degrees angles

230 (235) 230 (235) As above Black BGA

231 (236) 231 (236) As above White BGAs

232 (237) 230 (235) As above TBGA

233 (238) 233 (238) As above Black CSPs

234 (239) 234 (239) As above White CSPs

240 240 VPDplus (MPA) NXT V3.0 and higher

249 252 Diagonal cut shield parts No longer used.  Certain parts 
supported by 252.

252 252 Multi-purpose vision type (part 
outline)

254 252 Odd-form parts Select an appropriate vision 
type based on part shape.
Override required  (Note 5)

Vision Types New P Pattern Part Type Notes

Old NXT 
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QD004-05 4. Part Data Settings
Note 1
Previously, it was possible to perform vision processing for all rectangular chips using vision 
type 10, however, when using frontlighting, due to the influence of leads and so forth on the 
body of the part, it is necessary to separate those parts previously supported by vision type 
10 into four types as detailed in the table below.

*1: There are cases where none of the vision types in the above table are applicable.  Some 
examples of such parts are rectangular parts other than rectangular chips, tantalum 
capacitors, or aluminum electrolytic capacitors with multiple leads inside the edge of the 
part body.  In this case, select an appropriate vision type from 123, 124, 144, or 180 and 
enter element information for the leads based on the shape of the part.

Note: Vision type 10 is automatically converted to 60, however, if another value has been specified in the 
override vision type value for the NXT, this value will be used.

Note: Refer to 4.6.2 "NXT vision types" for details on how to create lead data.

Note 2
Vision type 20 is used on existing machines to process SOT-type parts with few leads, 
however, on the NXT machines, vision type 180 is used.  A custom vision type is used for 
power transistors.

Note: Vision type 20 is automatically converted to 180, however, if another value has been specified in the 
override vision type value for the NXT, this value will be used.

Vision type 
for existing 
machines

Vision type 
for NXT

Part type Explanation

10 60 Rectangular chips Automatically converted to 60 if 
no vision type value is specified 
in the NXT override section

65 Aluminum electrolytic 
capacitors

Element data not required

180 Tantalum capacitors Element data reguired

*1 Leaded parts Element data required

Vision type 
for existing 
machines

Vision type 
for NXT

Part type Explanation

20 180 Tantalum capacitors, 
SOTs

Automatically converted to 180 if 
no vision type value has been 
specified in the NXT override 
section.

75 Power transistors P_pattern automatically 
converted
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4. Part Data Settings QD004-05
Note 3
Vision type 40 is used on existing machines to process parts with backlighting, using the 
calculated body position as the placing reference point.  The NXT machine, however, can 
use either the body center or part center for the leaded (bumped) type parts.  As a result, 
there is no need to select a custom vision type.  Select the appropriate vision type from the 
following table based on the part type.

*2: Use the appropriate vision type (123, 124, 152, 153, or 180) depending on the leads and 
the lead quantity.

Note: Vision type 40 is automatically converted to 160, however, if another value has been specified in the 
override vision type value for the NXT, this value will be used. 

Note 4
Vision type 150 is used on existing machines to process connectors with backlighting, 
however, this vision type has now been separated as shown in the table below based on 
body color.

Note: Vision type 150 is automatically converted to 153, however, if another value has been specified in the 
override vision type value for the NXT, this value will be used.

Vision type 
for existing 
Machines

Vision type 
for NXT

Part type Explanation

40 160 White bodied 
connector detection

Automatically converted to 160 if 
no vision type value has been 
specified in the NXT override 
section.

60 Rectangluar chips

252 Multi-purpose (part 
outline)

*2 Leaded parts P_pattern automatically 
converted

Vision type 
for existing 
Machines

Vision type 
for NXT

Part type Explanation

150 153 White bodied 
connectors

Automatically converted to 153 if 
no vision type value has been 
specified in the NXT override 
section.

152 Black bodied 
connectors

P_pattern automatically 
converted
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Note 5
Vision type 254 is used on existing machines to place odd-form parts using backlight.  On 
NXT machines, this vision type has been changed as shown in the table below.

*3: On existing machines, vision type 254 uses backlighting to place parts that cannot be 
placed using other vision types, however, as NXT machines use only frontlighting, it is 
necessary to choose the most appropriate vision type available.  Select vision type 252 
when placing white bodied parts with no leads.  Vision type 252 can also be used for white 
bodies parts with leads that are part of the body.   If using a different vision type, element 
data will be required depending on the selected vision type.

Note: Vision type 254 is automatically converted to 252, however, if another value has been specified in the 
override vision type value for the NXT, this value will be used.

4.7.3 Entering overrides in part data
Procedure
1. Open the shape data (or part data if using non-relational mode) for the part data for 

which input is required in Fuji Flexa.

2. Refer to Vision Type Compatibility Table for Existing and NXT Machines and enter the 
new vision type in the NXT override [Vision Type] data field.

3. Refer to Vision Type Compatibility Table for Existing and NXT Machines and enter any 
new element information in the NXT override [Element Information] setting.

4. Save the data and exit.  If the data was changed in the job, save the job.

Note: If the shape data was changed in the global library, the same shape data in any jobs for the NXT must 
be updated.  Use the [Update in Jobs] command from the editor to perform this function.  If the data was 
changed in the job and the data is to be used in the future, it is possible to export the changed shape 
data back into the shape library.

Vision type 
for existing 
machines

Vision type 
for NXT

Part type Explanation

254 252 Multi-purpose (part 
outline)

Automatically converted to 252 if 
no vision type value has been 
specified in the NXT override 
section.

*3 Element data required
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MEMO:
94 NXT Programming Manual



QD004-05 5. Transmission
5. Transmission
5.1 Introduction

Transmission is used to send data between Fuji Flexa and the NXT machines.  The most 
common use of Transmission is to send jobs to the modules on the NXT.  Transmission for 
the NXT does not require outside communication programs such as an NTCC or SECS/
GEM host server.  From NXT control software V2.70, a basic data check of the job is 
performed during transmission.

The NXT is different from previous Fuji machines in that the job is sent to the modules, not 
recipes.  In addition, there is only two positions for jobs, current job and next job.  On NXT 
machines with double conveyors, there is an additional set of separate positions for jobs for 
the second lane.  It is possible to run the machine with two different jobs, one for lane 1 and 
the other for lane 2.  

The NXT does not have any calibration data or spec data like previous Fuji machines.  
Special NXT data and configuration settings is received, managed, and transmitted to the 
machine through Accessory Software.  Refer to the Accessory Software Operation Manual 
for more details on this subject.
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5.2 Transmitting
5.2.1 Transmitting a job from Job Builder

Follow the procedures below to transmit a currently opened global job to the NXT from 
within Job Builder.  Be sure to save the job before transmitting.

1. Select [Transmit]  from the [Tools] menu.

Note: The currently opened job can only be transmitted to the line that is used in the job.

2. The [Transmit Options] dialog box displays.  Select the desired options and click [OK].

3. Select the machine to which to transmit and click [Start].

4. During transmission, the [Transmit] dialog box displays.  This dialog box displays the 
transmission status.  If any errors occur, click [Error Details] to display further 
information about the errors.  Click [Close] to close the dialog box when transmission is 
completed.

Note: The lane to which the job is transmitted is determined by the lane for which the job was optimized for 
the NXT machine.

Note: The job name displays in the list of programs at the machine with the job name and a  T for the top side 
and  B for the bottom side and the revision displays before these items.

5.2.2 Dragging and dropping jobs to transmit 
Follow the procedures below to transmit a job to the NXT by dragging and dropping the job 
in the Transmission Control view. 

1. With the Transmission Control window displayed, drag the desired job from the global 
directory in the job pane and drop it on either the NXT line, machine, or lane in the 
Factory/Line pane.

Note: If the job is dropped on a lane, then that line, machine, and lane are automatically selected in the 
[Transmit Job] dialog box.  If the job was just dropped on the NXT machine, then both lanes for the NXT 
are automatically selected.

2. The [Transmit Job] dialog box displays.  In [Job:], the selected job is automatically 
selected.  Select the side of the panel to transmit.

3. The line and machine the job was dropped on is automatically selected.  The machines 
to which can transmitted have a small panel icon to the left of the machine nickname.  
The machines for which the job is not ready to be transmitted or jobs that are from the 
local job directory have small panel icon with a red X across it.

Note: A job from the local job directory cannot be transmitted to any NXT machines.  Only jobs from the global 
job directory can be transmitted.

4. Select the lanes to which to send the job from the [Lane] drop-down list.  If the job was 
dropped on a lane, then that lane is automatically selected.

5. Select any desired options from the bottom of the dialog box and click [Send] to transmit.
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QD004-05 5. Transmission
6. During transmission, the [Transmission Status] dialog box displays.  This dialog box 
displays the job and machines.  The transmission status is displayed to the right of the 
machine nickname.  If any errors occur, click [Error Details] to display further information 
about the errors.  Click [Close] to close the dialog box when transmission is completed.

Note: The job name displays in the list of programs at the machine with the job name and a  T for the top side 
and  B for the bottom side and the revision displays before these items.

5.2.3 Using [Transmit] to transmit
Follow the procedures below to transmit a job from within Director using the [Transmit] 
command.

1. Select [Transmit]  -  [Job…] from the [Tools] menu in Director.

2. The [Transmit Job] dialog box displays.  Next to [Job:] displays the job to be transmitted.  
If a job does not display or the job is incorrect, click [Browse] to display the [Select Data] 
dialog box.  Select the job to transmit and click [Open].  Select the side of the panel to 
transmit.

3. Select the name of the line to transmit to from the [Line:] drop-down list.  When a line is 
selected, the machines to which can transmitted have a small panel icon to the left of 
the machine nickname.  The machines for which the job is not ready to be transmitted 
or jobs that are from the local job directory have small panel icon with a red X across it.

Note: A job from the local job directory cannot be transmitted to any NXT machines.  Only jobs from the global 
job directory can be transmitted.

4. Select the lanes to which to send the job from the [Lane] drop-down list.

5. Select the target machines for transmission.  The machines with a red X across the 
panel icon cannot be selected.

6. After selecting the target machines for transmission, select any desired options from the 
bottom of the dialog box and click [Send] to transmit.

7. During transmission, the [Transmission Status] dialog box displays.  This dialog box 
displays the job and machines.  The transmission status is displayed to the right of the 
machine nickname.  If any errors occur, click [Error Details] to display further information 
about the errors.  Click [Close] to close the dialog box when transmission is completed.

Note: The job name displays in the list of programs at the machine with the job name and a  T for the top side 
and  B for the bottom side and the revision displays before these items.
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5.3 General Procedures
5.3.1 Changing the current job

The current job is the job that is used when production is started.  The other job for the 
selected lane is considered to be the next job.  Follow the procedures below to change the 
next job into the current job, however the machine must be at the main page for this 
operation to be successful.  If any other page is selected, then an error occurs when 
performing the following procedures.  The job can also be switched at the modules.

1. Double-click the factory folder from [Transmission Control] to display the target line, and 
then double-click the line to display the machines in that line.

2. Double-click the machine name to display the lanes for that machine.

3. Double-click the lane for which to change the job and the current job and next job display 
in a list.

4. Right-click the job name to be changed and select [Switch Recipe] from the shortcut 
menu. 

5. A dialog box displays with the status of the change.  Click [OK] to close the dialog box.

5.3.2 Deleting a job from a machine
1. Double-click the factory folder from [Transmission Control] to display the target line, and 

then double-click the line to display the machines in that line.

2. Double-click the machine name to display the lanes for that machine.

3. Double-click the lane for which to delete the job and the current job and next job display 
in a list.

4. Right-click the job to be deleted and select [Delete] from the shortcut menu. 

5. A dialog box displays with the status of the command.  Click [OK] to close the dialog box.
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6. Editing Jobs on the Machine
6.1 Introduction

If panels are in a NXT machine, it is not possible to edit the job and then transmit the edited 
job back to the foreground in the machine using Fuji Flexa.  Instead, MEdit is used to edit 
jobs that are on machines.  The job data that can be edited in MEdit is “safe” to change 
while there are panels in the machine.  If Fuji Flexa is used to edit the job, data that can 
cause problems for partially produced panels can be changed and when the job is sent to 
the machine, production problems occur.  For example, if a job is reoptimized, it is possible 
that the feeder setup and insert order across modules will be changed.  If a partially 
produced panel is in the machine, parts that were previously placed might be placed again 
on the panel or there may be missing parts.  MEdit limits the things that can be changed to 
prevent these sort of problems from happening.  In addition, MEdit also provides some 
specialized functions for working with the NXT such as the skip functions and the job test 
function. 

In addition to MEdit, VPDplus can also be used to edit vision data for parts.  The NXT 
application CD has a special limited-function free version of VPDplus that allows some of 
the basic VPDplus editing functions to be used if a VPDplus license is not available.  Do not 
use this version if licensed “normal” VPDplus software is on the computer already.

There is one point about MEdit that should be understood.  When the current job that is in 
the machine is opened in MEdit, the actual data from the machine is not being accessed.  
MEdit checks what job is in the machine and then opens the matching job in the global 
directory. 

The procedures provided in this chapter are basic procedures for MEdit.  For details on 
MEdit and using it, refer to the MEdit Operation Manual.
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6.2 Skipping Items on the NXT
6.2.1 Skipping boards (NXT V3.10 and higher)

If always a particular board in a panel production lot needs to be skipped for some reason, 
it is easy to specify a skip for this board for the production lot.  There are a few important 
points that should be addressed when using this function.

• When the board to be skipped is specified for the first module, that board is 
skipped in all modules after the first module.

• The skip setting is only applied to new panels which means that the setting is 
not applied to any panels already loaded.

• Job board skip settings and board skips due to skip marks cannot be overridden 
by this function.

• Machine configuration settings must be made for this function to be enabled and 
panel conveyance time in increased (around 300 ms) when this setting is 
enabled.

• If a certain board is to always be skipped for all production lots, then skip the 
board in the job with Fuji Flexa. 

• If the boards to be skipped are not set (changes from panel to panel), then use 
skip marks to skip the required boards.

Specifying the machine configuration setting to enable this function.
1. Start Accessory Software and click the name of the machine for which to change the 

setting in Floor Monitor.

2. If necessary, specify a user ID from the drop-down list and enter a password for the 
specified user and click [Log on].  The machine accessories page is displayed.

3. Click [Machine Configuration] in the [Menu] pane.  Accessory Software connects to the 
machine and receives the machine information.  When completed, the settings page is 
displayed.

4. Select [Skip boards at the machine setting] from the [Category] drop-down list.  The 
settings for this category are then displayed.

5. Select the [ON] option for the [Skip boards at the machine] setting.

6. Click [Send to Machine] to send the new setting to the machine.  The setting is enabled 
once the completed message is displayed.

Skipping a board at the machine.
1. Before loading the panel belonging to the lot for which board skipping is to be performed, 

verify that no panels exist inside the first module, and push CYCLE STOP to stop 
production.

2. Start MEdit and select [Board skip] from the [Tool] menu.  The [Board skip] dialog box 
is displayed.

3. Select the factory, line, NXT machine and then first module in the [Module list].  A list of 
the available boards and lanes is displayed in the [Board skip settings] list.  
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4. Select the checkboxes for the lane and boards to be skipped. 

5. Click [OK] to apply the skip settings and then close MEdit.

Note: The new skip setting is only applied to panels that are loaded in the module after this setting is made.

6. Begin production and load the panels for which the board skip is to be applied. 

When boards are specified to be skipped, the skipped boards are displayed in the operation 
panels on the modules.  Confirm that the boards to be skipped are correct.  Be sure to 
remove the skip setting when switching to a production lot in which the previously skipped 
board is to be produced.

6.2.2 Skipping feeders (NXT V2.95 and higher)
Use this function to skip all the parts from a feeder.  This allows production to be completed 
for panels when parts are no longer available for the parts that have run out.  It is important 
to note the following points about this function.

• When parts are skipped, the panel is completed without placing the skipped 
parts.

• This function should only be used if it absolutely necessary to skip a part to 
complete production such as when a certain part runs out and will be placed on 
the panel at a later time once new parts are received.

• This function is designed to be used by line management personnel.

• Be careful when using this function.

Skipping a feeder on a module.
1. As soon as a part supply runs out during production, the machine waits for the parts to 

be supplied in a "recovery up" status.  Perform the following steps only if parts are not 
available to be resupplied.

2. Push CYCLE STOP at the module in question to stop production for that module.

NXTEJM001
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3. Start MEdit and select [Feeder skip] from the [Tool] menu.  The [Feeder skip] dialog box 
is displayed.

4. Select the factory, line, NXT machine, and the module in the [Module list].  A list of the 
available feeders is displayed in the [Feeder skip settings] list. 

5. Select the checkbox for the feeder with the parts to be skipped. 

6. Click [Set] to apply the skip setting and then close MEdit.

Note: If a place before setting is set for a skipped part, the place before setting is disabled.  Simultaneously 
skip the 2 related feeders for the "place before" setting.

7. Push START at the module in question to restart production.  Production is continued 
without placing parts from the skipped feeder position.

Note: It is not necessary to have a feeder in the skipped position in order to continue production.  However, it 
is necessary to have an empty drawer set in the skip position if a tray part is skipped on a tray unit-L.

All of the LEDs for the feeder position are on for skipped feeder positions.  For tray parts, 
skipped positions have a white numbers and the part comment text is grey in the parts out 
guidance screen.

Clearing the skip setting for a feeder on a module.
1. Push CYCLE STOP at the module before the module with the skipped part (this 

prevents any new panels from being loaded into the next module).  

2. Wait until all panels are unloaded from the module with the feeder skip and then push 
CYCLE STOP on that module.

3. Start MEdit and select [Feeder skip] from the [Tool] menu.  The [Feeder skip] dialog box 
is displayed.

4. Select the factory, line, NXT machine, and the module with the skipped feeder in the 
[Module list].  A list of the available feeders is displayed in the [Feeder skip settings] list. 

5. Clear the checkbox for the feeder with the parts that are being skipped. 

6. Click [Set] to apply the cleared skip setting and then close MEdit.

Note: If a place before setting is set, be sure to clear the skip settings simultaneously for the 2 related feeders 
with the "place before" setting.

7. Set the new parts in the module in the specified position.

8. Push START at the module in question to restart production.  Production is continued 
and the newly supplied parts are placed.
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6.2.3 Skipping holders (NXT V3.00 and higher)
Use this function to skip using a holder for a head on a module.  This function makes it 
possible to not use a specified holder in order to avoid using a holder at which frequent 
errors occur during production or for which air leakage or clogging problems prevent normal 
use.  In addition, the holder skip function serves as a calibration information backup 
measure.  It is important to note the following points about this function.

• A holder skip status is canceled when a head change occurs.

• A holder for which calibration using a jig nozzle has not been completed cannot 
be skipped.

• The holder skip function cannot be used for the H01 head, or in cases where a 
skip would leave no remaining nozzles for production.

• The holder skip function cannot be used in cases where the Q-axis and/or R-
axis are not operating normally or in cases such as mechanical valve failure, in 
which other holders remain unaffected.

• Recovery processing occurs for parts that were supposed to be placed by the 
skipped holder.  Therefore, the skip function reduces throughput.

• When skipping a holder due to a holder failure, verify that the other holders are 
operating normally.

• The nozzle in the skipped holder is returned to the nozzle station.  If the nozzle 
cannot be returned to the station due to some failure, remove the nozzle by 
hand.

• It is possible that an accuracy deviation may occur using a head after a failed 
holder has been skipped.

Skipping a holder on a head.
1. If START has not yet been pushed and the main screen is displayed after turning on the 

power, push START to turn on the power to the head.  Then stop the machine.

2. Ensure that the main screen is displayed at the module.

3. Start MEdit and select [Holder skip] from the [Tool] menu.  The [Holder skip] dialog box 
is displayed.

4. Select the factory, line, NXT machine, and the module in the [Module list].  A list of the 
available holders on the head is displayed in the [Holder lists]. 

5. Select the checkbox for the holder to be skipped. 

6. Click [Set] to apply the skip setting and then close MEdit.

7. Push START at the module in question to restart production.  Production is continued 
without using the skipped holder.

Note: If the skipped holder is holding a part, discard it.  Return the nozzle to the nozzle station if necessary.

When holders are specified to be skipped, the skipped holders are displayed in the 
operation panel on the module.  Confirm that the holder to be skipped is correct. 
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Clearing a holder skip setting for a head.
1. Push CYCLE STOP at the module with the skipped holder to stop production.

2. Ensure that the main screen is displayed at the module.

3. Start MEdit and select [Holder skip] from the [Tool] menu.  The [Holder skip] dialog box 
is displayed.

4. Select the factory, line, NXT machine, and the module in the [Module list].  A list of the 
available holders on the head is displayed in the [Holder lists]. 

5. Clear the checkbox for the holder being skipped to clear to skip setting. 

6. Click [Set] to apply the cleared skip setting and then close MEdit.

7. Push START at the module in question to restart production.  Production is continued 
using the previously skipped holder.
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6.3 Correcting Vision Errors Sent from the NXT
From NXT V2.81 and higher, it is possible to make settings that if a vision error occurs for 
a particular feeder position, then the vision error image will automatically be sent to the 
Accessory Software Server.  In Accessory Software, the image can then be opened with 
VPDplus and used to check the error condtion and make any corrections as necessary.  
The data is then sent back to the job in the global server.  Once it has been saved back in 
the job, MEdit is then used to retransmited the edited job back to the machine.  This function 
is very useful to help troubleshoot vision data issues with parts that have intermediate vision 
errors.

Note: It is not recommended to make settings so that any vision error is set to the Accessory Software Server 
for all slots.  This is due to the fact that when a vision error occurs and the image is to be saved to the 
Accessory Software Server, the module pauses production while the image is being sent to Accessory 
Software.  If many vision errors occur, then production can be delayed while waiting for the images to 
be sent to the server.  This is mainly designed to be a troubleshooting tool only.

6.3.1 Specifying vision error images to be saved for certain positions 
(NXT V2.81 and higher)

If a particular part has frequent vision errors during production, it is possible to specify that 
vision error images for that part to be sent to the Accessory Software Server.  There are a 
few important points that should be addressed when using this function.

• A maximum of 10 images can be saved at the Accessory Software Server.

• The module pauses production while error images are being sent and saved to 
the Accessory Software Server.

1. Start Accessory Software and select the module for the machine from which to save 
vision error images in Floor Monitor.  

2. With the module in question selected, click the vision processing error analysis icon (the 
green icon with the picture of a part) for the machine from which to receive vision error 
images.  The [Vision processing error analysis] screen is displayed.

3. Click [Vision processing setting] at the top right of the [Vision processing error analysis] 
screen.  A list of used feeder positions in the selected module is displayed.

4. Select the checkboxes for the positions for which to save vision error images.

Note: If [Detailed Settings] is clicked, it is possible to make special settings for which error images and under 
what conditions are images sent to Accessory Software for positions.  It is even possible to specify that 
only certain errors are to be sent.

5. Click [Apply] to enable the settings.

Note: If the power to the machine is turned off or a new job is transmitted, these settings are cleared.

Note: When a vision processing error occurs at an alternate feeder, the image is saved based on the settings 
specified for the original feeder.
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6.3.2 Viewing saved vision error images
Once an error image has been sent to Accessory Software, it can be displayed in any client 
accessing Accessory Software.  The details of the error and the image are displayed by 
following the procedures below.

1. From Floor Monitor, select the module from which to view error images and then click 
the vision processing error analysis icon for that machine.  The [Vision processing error 
analysis] screen is displayed with information for all of the saved images for the selected 
module.

• Click [Enlarge] below a image to display that image larger.

• Click the blue text for the error code to display details about that error code.

• If there are more pictures than can fit on one page, multiple page numbers are 
displayed at the bottom of the page.  Click the other page number to display the 
images for that page. 

• The image can be opened/saved by clicking on it.  If VPDplus and VPDplus 
launcher have been installed on the computer, then the image is opened in 
VPDplus and the vision data can be edited.

6.3.3 Opening and editing vision data using saved images
If VPDplus and VPDplus Launcher have been installed on the computer accessing the 
Accessory Software, then it is possible to open and edit the vision data for the part using 
VPDplus and then reflect any changes back to the job in the server.  It is important to note 
the following two points.

• VPDplus must be installed on the computer.  If the limited-function free version 
is installed, then only the functions available from that version can be used.  If 
the licensed version of VPDplus is installed and the license is present, then 
those functions for that version can be used (such as fit and vision test).  Refer 
to the VPDplus Installation Manual for details on installing VPDplus.

• VPDplus Launcher must be installed on the computer.  This software links the 
images to the shape data and to VPDplus.  This software is available from the 
download section of the Accessory Software website.  If not installed, then 
download and install it before attempting to open an image.

1. From Floor Monitor, select the module from which to view error images and then click 
the vision processing error analysis icon for that machine.  The [Vision processing error 
analysis] screen is displayed with information for all of the saved images for the selected 
module.

2. Display the image of the part to be edited with VPDplus.

3. Click the image and a [File Download] dialog box is displayed.

4. Select [Open] and the image is opened using VPDplus. 

5. Edit the data as necessary.  For details on editing items in VPDplus, refer to the VPDplus 
Operation Manual or online help.

Note: If using a licensed version of VPDplus, be sure to perform a vision test of the edited settings before 
saving them back to the job and restarting production.
106 NXT Programming Manual



QD004-05 6. Editing Jobs on the Machine
6. Once editing is completed, select [Update Shape Data] from the [File] menu.  A 
confirmation message box is displayed.

7. Click [Yes] and the edited vision data is saved to the job.

8. Close VPDplus.

6.3.4 Sending edited vision data back to the machine
The edited data was saved to the job in the global job directory by using the Update Shape 
Data command in VPDplus.  In order to use this newly edited vision data at the machine, it 
must be sent to the machine.  Use MEdit to open the current job for the module with the part 
and then retransmit the job back to the module in question.  Refer to the sections in this 
chapter for procedures on opening the current job in the machine and for retransmitting the 
job back to the machine.
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6.4 Opening a Job that is in the Machine
By following the procedures below, the job in the global directory that matches the job that 
is currently in the machine is opened.  When this is performed, changes made to the job 
can be sent to the machine as well as being saved in the global job.  

Note: It is possible to open the same job with the [Open Job] command but if this command is used, then 
changes cannot be sent to the machine. 

1. Click [Start] and then point to [Programs] - [Fuji NXT Accessory] and then click [MEdit].  
MEdit is started and the MEdit window displays.

2. Click [Open Current Job] from the [File] menu.  The [Acquire current production job] 
dialog box displays.

3. Select the line with the machine for the job to be edited in the left pane and then select 
machine in the right pane.  The name of the selected job is automatically displayed in 
the [Job Name] dialog box.

4. Select the side of the panel to be edited and then specify the module from which to edit 
the data.

5. Click [OK] and the specified data from the job is opened.

Note: Use the [Open Job] command to open a job that is not in a machine.  It is not possible to transmit a job 
opened this way to a machine from MEdit. 

Once the job is opened, it can be edited or tested.  For procedure on editing items in MEdit, 
refer to the MEdit Operation Manual.  The procedures for testing a job are provided in the 
next section.  Once the job has been edited/tested, retransmit the changes back to the 
machine in order for the machine to be able to use the edited data.
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6.5 Testing Jobs (NXT V3.10 and higher)
6.5.1 Introduction

The job test function enables users to view and edit jobs on the machine prior to starting 
production.  By doing this, errors that occur during the beginning of production for a new job 
can be greatly reduced.  There are two job test modes and the items checked by each mode 
are different.  Information about these two modes are provided below.

Simulation
The placement position for a specified sequence is captured using the mark camera and 
the panel pattern is compared graphically with the part image (wire frame) in MEdit.  This 
allows the operator to check for any placement position deviations and problems with the 
placing angle.  In addition, it is possible to confirm that the part type is roughly correct by 
comparing the wire frame of the part graphic to the actual pad arrangement.  If there are 
any calculated placing deviations, they can be corrected easily in MEdit and be reflected 
back to the job.

The main items checked by this mode are fiducials, placement position, orientation, and 
part types compared to the pads.  Actual parts are not required to perform this test, just an 
actual panel is required.  If any problems with these items are located, corrections can be 
made and checked again.

Place & Check
Parts are picked, vision processed and placed on the panel.  Once a part is placed, the 
mark camera takes an image of the position and that image is then displayed in MEdit with 
a part graphic overlay in MEdit.  This allows the operator to check for pickup errors, vision 
errors, actual placement position deviations and problems with the placing angle.  If there 
are any errors, they can be corrected in MEdit and be reflected back to the job.

The main items checked by this mode are fiducials, feeding, feeding direction, vision data, 
placing data, actual placement position, and orientation.  Actual parts are required to 
perform this test as well as an actual panel.  If any problems with these items are located, 
corrections can be made and checked again.

6.5.2 Testing a job using simulation mode
Use this mode to perform a basic check of the part types, placing positions and orientation. 

Starting simulation mode.
1. Transmit the job to be tested to the machine and wait for the main screen to display on 

all of the operation panels for the modules.

2. Start MEdit and log on if necessary.

3. Click [Open Current Job] from the [File] menu.  The [Acquire current production job] 
dialog box displays.

4. Select the line with the machine for the job to be tested in the left pane and then select 
machine in the right pane.  The name of the selected job is automatically displayed in 
the [Job Name] dialog box.

5. Select the side of the panel to be tested and then specify the module from which to test 
the data.
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6. Click [OK] and the specified data from the job is opened.

7. Select [Job Test] - [Simulation] from the [Tool] menu.  The background color of the 
operation panel for the module in question turns violet to indicate that that module is in 
a test mode.  There are several conditions in which the module cannot be changed to 
simulation mode and an error occurs.

Checking part positions and direction.

8. Select the sequence to be checked from the list in MEdit and click the break point button 
(the round red button).  This designates that the sequence is to be checked and the 
sequence gets a red circle icon in the beginning column of that sequence.  

Note: It is possible to specify multiple break points.  The sequences with the break points are stopped at and 
the captured image is sent to MEdit to be checked.  The images for non-break point sequences are not 
set to MEdit to be checked, unless the next sequence command is being used.

9. If desired, specify a starting sequence for the check by selecting the sequence to start 
the machine from and then click the start sequence button (the yellow arrow button).  
When the check is started, this will be the sequence at which the check will start. 

NXTEJM007
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10.Click the start button (the green triangle button pointing to the right) to start the check.  
The machine starts the conveyor and once a panel is loaded, clamps it and starts the 
check from the designated sequence.  The machine uses the mark camera to acquire 
images of the placing positions and these display on the operation panel.  Once a break 
sequence is reached, the machine acquires that position image, stops, and transmits 
the image to MEdit.  This image is then displayed in MEdit with a part graphic overlay.

11.Check the coordinates and angle of the part graphic in relation to the pads on the panel.  
If it is necessary to change the X- or Y-position of the part, the coordinates can be 
directly edited or click the positioning button (the button with the four arrows) and then 
click and drag the graphic until it is positioned correctly.  The direction can be changed 
by clicking the rotation button (the button with the arrow shaped as a circle).

12.Once completed with any necessary adjustments for the displayed position, click the 
start button to continue until the next break point or click the step button (the button with 
the triangle pointing at the line) to check the next sequence (even if it does not have a 
break point set).

13.Continue checking sequences until all desired sequences have been checked.

Note: There are times in which MEdit will ask if the changed job should be retransmitted back to the machine.  
If the job has been retransmitted and there have been no further changes to the job, then proceed to 
step 18.  This is because the most current data is already in the machine so it is not necessary to 
retransmit the job again.  If not sure whether or not the changes to the job have already been sent to 
the machine then, proceed to the next step.  There are no problems if the job is retransmitted to ensure 
that the current data is in the machine.
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Sending changes back to the module.

14.Once the sequences have been checked, click [Run Data Checker] from the [File] menu 
to check the job for any problems.  Once the data checker has completed checking the 
job, retransmit the data back to the module.

15.Select [Retransmit Job] from the [File] menu to send the changes back to the module.

Note: It is possible to transmit the job to the module when the yellow engineering pictogram is displayed on 
the operation panel of the module.

16.Recheck any changes to sequences if necessary.

Exiting simulation test mode.

17.Once all testing for simulation mode has been completed, select [Job Test] - [Exit] from 
the [Tool] menu.

That completes the testing of the job on the specified module with simulation mode..
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6.5.3 Testing a job using place & check mode
Use this mode to perform a check of the pickup data, vision data, carrying data, part types, 
placing data, actual placing conditions, and orientation. 

Starting place & check mode.
1. Transmit the job to be tested to the machine and wait for the main screen to display on 

all of the operation panels for the modules.

2. Start MEdit and log on if necessary.

3. Click [Open Current Job] from the [File] menu.  The [Acquire current production job] 
dialog box displays.

4. Select the line with the machine for the job to be tested and then select the machine.

5. Select the side of the panel to be tested and then specify the module from which to test 
the data.

6. Click [OK] and the specified data from the job is opened.

7. Select [Job Test] - [Place & Check] from the [Tool] menu.  The background color of the 
operation panel for the module in question turns violet to indicate that that module is in 
a test mode.  There are several conditions in which the module cannot be changed to 
place & check mode and an error occurs.

Checking part positions and direction.
8. Select the sequence to be checked from the list in MEdit and click the break point button 

(the round red button).  This designates that the sequence is to be checked and the 
sequence gets a red circle icon in the beginning column of that sequence.  

Note: It is possible to specify multiple break points.  The sequences with the break points are stopped at and 
the captured image is sent to MEdit to be checked.  The images for non-break point sequences are not 
set to MEdit to be checked, unless the next sequence command is being used.

Note: It is not possible to specify a starting sequence for place & check mode.  If the module is stopped during 
production and then switched to this mode, the beginning sequence is the sequence at which production 
was stopped.

9. Click the start button (the green triangle button pointing to the right) to start the check.  
The machine starts the conveyor and once a panel is loaded, clamps it and starts the 
check from the first/stopped sequence.  The machine picks parts, vision processes them 
and then places them and then the mark camera acquires an image of the placed part 
and position and this displays on the operation panel.  Once a break sequence is 
reached, the machine acquires that position image, stops, and transmits the image to 
MEdit.  This image is then displayed in MEdit with a part graphic overlay.

Note: It is necessary to have feeders set in the module to be tested when using place & check mode because 
parts are picked from the feeder.

10.Check the coordinates and angle of the part and graphic in relation to the pads on the 
panel.  If it is necessary to change the X- or Y-position of the part, the cooridnates can 
be directly edited or click the positioning button (the button with the four arrows) and then 
click and drag the graphic until it is positioned correctly.  The direction can be changed 
by clicking the rotation button (the button with the arrow shaped as a circle).
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11.Once completed with any necessary adjustments for the displayed position, click the 
start button to continue until the next break point or click the step button (the button with 
the triangle pointing at the line) to check the next sequence (even if it does not have a 
break point set).

12.Continue checking sequences until all desired sequences have been placed & checked.

Note: There are times in which MEdit will ask if the changed job should be retransmitted back to the machine.  
If the job has been retransmitted and there have been no further changes to the job, then proceed to 
step 16.  This is because the most current data is already in the machine so it is not necessary to 
retransmit the job again.  If not sure whether or not the changes to the job have already been sent to 
the machine then, proceed to the next step.  There are no problems if the job is retransmitted to ensure 
that the current data is in the machine.

Sending changes back to the module.
13.Once the sequences have been checked, click [Run Data Checker] from the [File] menu 

to check the job for any problems.  Once the data checker has completed checking the 
job, retransmit the data back to the module.

14.Select [Retransmit Job] from the [File] menu to send the changes back to the module.

Note: It is possible to transmit the job to the module when the yellow engineering pictogram is displayed on 
the operation panel of the module.

15.Recheck any changes to sequences if necessary.

Exiting place & check test mode.
16.Once all testing for place & check mode has been completed, select [Job Test] - [Exit] 

from the [Tool] menu.

That completes the testing of the job on the specified module with place & check mode..
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6.6 Testing Pickup Positions (NXT V3.20 and higher)
6.6.1 Introduction

The pickup test function enables users to check and edit pickup positions in jobs on the 
machine prior to starting production.  By doing this, pickup errors that occur during the 
beginning of production can be greatly reduced.  There are two pickup items that can be 
tested.  The pickup X- and Y-positions can be checked and edited from NXT V3.20 and 
later.  The pickup height can be tested and edited from NXT V3.40 and later.  Both of these 
items can be used for parts in feeders or trays.  Tray pickup data such as the pickup position 
and pitch data can also be edited by using this function for trays.

6.6.2 Testing pickup positions in a feeder
Use this to check and edit the X-, Y-, and Z-positions for picking parts in feeders. 

Starting the pickup test.
1. Transmit the job with the pickup position to be tested to the machine and wait for the 

main screen to display on all of the operation panels for the modules.

2. Start MEdit and log on if necessary.

3. Click [Open Current Job] from the [File] menu.  The [Acquire current production job] 
dialog box displays.

4. Select the line with the machine for the pickup positions to be tested in the left pane and 
then select machine in the right pane.  The name of the selected job is automatically 
displayed in the [Job Name] dialog box.

5. Specify the module from which to test the pickup position data.

6. Select the [Feeder Setup] tab.

7. Select the slot for which the pickup test is to be performed.

8. Select [Pickup Check] from the [Tool] menu.  The background color of the operation 
panel for the module in question turns violet to indicate that that module is in a test mode.  
There are several conditions in which the module cannot be changed to this mode and 
an error occurs.
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Note: Indexing is not performed automatically for feeders on which a pickup position test is performed.  
Manually feed the parts to the pickup position.  Furthermore, the feed count differs depending on the 
feeder.  Refer to section “6.6.4 Feeder index count and tape return method for pickup tests” for further 
details. 

9. Select the type of tests which are to be performed in the dialog box that is displayed.  If 
the [Edit Pickup Position] option is selected, proceed to the next step.  If the [Measure 
Pickup Height] option only is selected, then proceed to step 13.

Note: Because the pickup height measurement uses pickup pressure control, the height measurement test is 
not possible using heads which have no pressure check sensor.  In such cases, the "Measure pickup 
Height" item cannot be selected.  Only the H01 and FO4 heads can be used to perform this test.
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Checking and editing the X- and Y-positions in the feeder.

10.The [Edit pickup position] step is displayed.  Ensure that the part has been advanced to 
the proper position (refer to section "6.6.4 Feeder index count and tape return method 
for pickup tests") then click [Acquire] to take a picture of the part in the feeder.  A picture 
of the part is taken and displayed.   

11.Check the pickup position in the X- and Y-direction using the displayed image.  To move 
the pickup position, click the positioning button (the button with the four arrows) and then 
click in the image where the pickup should be performed. 

12.When the pickup position for the part is correct, click [Next].  If the pickup height test is 
not being performed, go to step 18.
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Checking and editing the pickup height for a feeder.

13.The [Measure Pickup Height] step is displayed.  Ensure that the part has been advanced 
to the proper position (refer to section "6.6.4 Feeder index count and tape return method 
for pickup tests") then click [Ref.] to specify which nozzle to use for the test.   

Note: The machine knows which nozzles are present in the module (if a check has been performed by the 
machine).  In cases where the job-specified nozzle can be used for the height measurement, that nozzle 
is automatically selected.

14.Select the nozzle to be used for the measurement in the dialog box that is displayed and 
then click [OK]. 

Note: If the module has not yet performed calibration and does not know what nozzles are present in the 
nozzle station, click [Measure] to have the module check which nozzles are present.

15.Click [Measure] to begin the pickup height test. 
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16.The results of the test are displayed and the Z offset is automatically determined.  It is 
possible to manually edit this value. 

Note: A dialog box is displayed when a stroke error occurs.  Click [Yes] in this dialog box to try moving the 
head down an extra 1 mm and measure again.  The same error occurs if there is no part in the pickup 
position.  If unsure if a part is present or not, check the part status in the feeder.

17.Once the Z offset has been determined and the results are acceptable, click [Next]. 

Sending changes back to the module.

18.The offset results for the pickup position test are displayed.  Check the results and if the 
results are acceptable, click [Finish].  It is possible to click [Back] to return to previous 
steps of the pickup test.
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19.A dialog box is displayed asking if the results should be sent back to the module.  Click 
[Yes] to send the new offset data back to the module.

20.A dialog box is displayed asking if Data Checker should be run or not.  Click [Yes] to 
check the job data with data checker.

21.Select the modules to which to sent the changes to the job data back and then click [OK].  
Note that is the same part is present in multiple modules, that it is important to select all 
of the modules that have the same part.
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6.6.3 Testing pickup positions in a tray
Use this to check and edit the pitch, X-, Y-, and Z-positions for picking parts in feeders. 

Starting the pickup test.
1. Transmit the job with the pickup positions to be tested to the machine and wait for the 

main screen to display on all of the operation panels for the modules.

2. Start MEdit and log on if necessary.

3. Click [Open Current Job] from the [File] menu.  The [Acquire current production job] 
dialog box displays.

4. Select the line with the machine for the pickup positions to be tested in the left pane and 
then select machine in the right pane.  The name of the selected job is automatically 
displayed in the [Job Name] dialog box.

5. Specify the module from which to test the tray pickup position data.

6. Select the [Feeder Setup] tab.

7. Select the slot for which the pickup test is to be performed.

8. Select [Pickup Check] from the [Tool] menu.  The background color of the operation 
panel for the module in question turns violet to indicate that that module is in a test mode.  
There are several conditions in which the module cannot be changed to this mode and 
an error occurs.
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9. Select the type of tests which are to be performed in the dialog box that is displayed.  If 
the [Calculate Tray Pitch] or [Edit Pickup Position] options are selected, proceed to the 
next step.  If the [Measure Pickup Height] option only is selected, then go to step 18.

Note: Because the pickup height measurement uses pickup pressure control, the height measurement test is 
not possible using heads which have no pressure check sensor.  In such cases, the "Measure pickup 
Height" item cannot be selected.  Only the H01 and FO4 heads can be used to perform this test.

Checking and editing the tray pitch and X- and Y-positions.

10.If the [Calculate Tray Pitch] option is selected, then specify two possible pick positions 
in the tray.  If the [Edit Pickup Position] is only selected, then select only one pickup 
position.  [Next] is not available until the required positions have been selected.   

Note: It is not necessary to select the first and last pickup positions.  Any position in the tray can be selected.  
However, if measuring the tray pitch, the measured results will be better if the two selected cavities are 
the furtherest from each other.  Tray positions past the top 250 mm of the tray cannot be selected due 
to restrictions in the travel range of the mark camera.
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11.Click [Next] and the [Edit First Cavity] step is displayed.   

12.Click [Acquire] to take a picture of the part in the first specified slot in the tray.  A picture 
of the part is taken and displayed.   

13.Check the pickup position in the X- and Y-direction using the displayed image.  If the 
pickup position needs to be moved, click the positioning button (the button with the four 
arrows) and then click in the image of the graphic at which the pickup should be 
performed (the [Offset] values are automatically changed). 

14.When the pickup position for the part is correct, click [Next].  If the tray pitch test is not 
being performed, then go to step 18.

15.The step for the second specified cavity is displayed (if tray pitch is being measured).  
Click [Acquire] to take a picture of the part in the second specified slot in the tray.  A 
picture of the part is taken and displayed.   

16.Check the second pickup position in the X- and Y-direction using the displayed image.  
If the pickup position needs to be moved, click the positioning button (the button with the 
four arrows) and then click in the image of the graphic at which the pickup should be 
performed (the [Offset] values are automatically changed). 

17.When the pickup position for the part is correct, click [Next].  If the pickup height test is 
not being performed, go to step 24.
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Checking and editing the pickup height for a tray.

18.The [Measure Pickup Height] step is displayed.  Specify the cavity position on which to 
perform the pickup test (a part must be present in the cavity) in the [Cavity] group.   

Note: Trays have a certain amount of warp. Therefore, the measurement should be performed at multiple 
cavities to determine the optimum pickup height.  (Fuji recommends measuring the center cavity and 
the 4 corner cavities.)

19.Click [Ref.] to specify which nozzle to use for the test.   

Note: The machine knows which nozzles are present in the module (if a check has been performed by the 
machine).  In cases where the job-specified nozzle can be used for the height measurement, that nozzle 
is automatically selected.

20.Select the nozzle to be used for the measurement in the dialog box that is displayed and 
then click [OK]. 

Note: If the module has not yet performed calibration and does not know what nozzles are present in the 
nozzle station, click [Measure] to have the module check which nozzles are present.

21.Click [Measure] to begin the pickup height test. 
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22.The results of the test are displayed and the Z offset is automatically determined.  It is 
possible to manually edit this value. 

Note: A dialog box is displayed when a stroke error occurs.  Click [Yes] in this dialog box to try moving the 
head down an extra 1 mm and measure again.  The same error occurs if there is no part in the pickup 
position.  If unsure if a part is present or not, check the part status in the feeder.

23.Once the Z offset has been determined and the results are acceptable, click [Next]. 

Sending changes back to the module.

24.The offset and pitch results for the pickup position test are displayed.  Check the results 
and if the results are acceptable, click [Finish].  It is possible to click [Back] to return to 
previous steps of the pickup test.
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25.A dialog box is displayed asking if the results should be sent back to the module.  Click 
[Yes] to send the new offset data back to the module.

26.A dialog box is displayed asking if Data Checker should be run or not.  Click [Yes] to 
check the job data with data checker.

27.Select the modules to which to sent the changes to the job data back and then click [OK].  
Note that is the same part is present in multiple modules, that it is important to select all 
of the modules that have the same part.
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6.6.4 Feeder index count and tape return method for pickup tests
When performing a pickup test, it is necessary to index the parts because the test does not 
automatically index them and there are certain cases in which indexing must be performed 
a certain number of times, depending on the feeder.  The feed count list is shown below. 

Index count based upon feeder type and pitch table
Tape Feeders

Stick Feeders

Note: Items in the () indicate that it might be possible to use that amount to index the part for the pickup test.  
However, there are times when a Y-axis movement tolerance error occurs and the pickup test cannot 
be performed because the pickup position will change based on calibration compensation or any pickup 
offset values (part size or smaller) and therefore the pickup position will be outside the valid movement 
range.

W08 W12 W16 W24 W32 W44 W56
Pitch Index amount Index amount Index amount Index amount Index amount Index amount Index amount

1 1 X X X X X X
2 1 X X X X X X
4 1 3 (1) 3 (1) 4 4 4 4
8 2 (1) 2 (1) 3 3 3 3
12 2 (1) 2 (1) 2 (1) 2 (1) 2 (1) 2 (1)
16 2 (1) 2 (1) 2 (1) 2 (1)
20 2 (1) 2 (1) 2 (1) 2 (1)
24 2 (1) 2 (1) 2 (1) 2 (1)
28 (1) (1) (1)
32 (1) (1) (1)
36 (1) (1)
40 (1) (1)
44 (1)
48 (1)
52 (1)
56 (1)

Feeder Width Type Chute Type Index Amount
24 mm 1S Top (1)
24 mm 1S Bottom X
24 mm 1L Top X
24 mm 1L Bottom X
48 mm 2S Top (1)
48 mm 2S Bottom X
48 mm 2L Top X
48 mm 2L Bottom X
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Indexing the tape

1. Check the chart and push the index button the number of times required to index the 
part forward.   

Returning the tape

1. Check the part and index the part back the number of times it was indexed forward by 
pushing the back button the same number of times.   

Note: The take-up lever is designed to prevent looseness in the top film when rotated correctly (i.e., the tape 
is indexed forward).  When rotated in the opposite direction, looseness in the top film develops.  
Eliminate this looseness manually by opening the take-up lever and gently pulling on the top film and 
then returning the take-up lever.

Carrier tape ER
R

PW
R

1 2 4

NXTFDR006

Carrier tape ER
R

PW
R

1 2 4

NXTFDR181

Cover tape

Take-up lever

Roller (upper side)

Roller (lower side)

NXTFDR008
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6.7 Testing Skip Mark Data in the Job
It is possible to test the skip mark data in a job for board skip marks and global skip marks.  
It is important to test the data because the skip mark read level that is used to determine if 
a skip mark is present or not must be manually set.  Due to color and reflective differences 
between panels for jobs, a level that is good for one job might not be good for another job.  
Thus it is important to test the data to ensure that the marks are correctly detected and there 
are no false detections. 

1. Click [Start] and then point to [Programs] - [Fuji NXT Accessory] and then click [MEdit].  
MEdit is started and the MEdit window displays.

2. Select [Open Current Job] from the [File] menu.  The [Acquire current production job] 
dialog box displays.

3. Select the line with the machine for the job to be edited and then select the machine.  
The name of the selected job is automatically displayed in the [Job Name] dialog box.

4. Select the side of the panel to be edited and specify the machine for which to edit the 
data from the drop-down list.

5. Click [Open] and the specified data from the job is opened.

6. Load the panel to be tested into the module to be used.

7. Push MANUAL on the operation panel of the module to be tested to change to manual 
mode.  The module must be in manual mode or the following steps cannot be performed.

8. Select [Board Skip Mark Read Test] from the [Tools] menu.  The [Board Skip Mark Read 
Test] dialog box opens and the skip mark data in the job is displayed

9. Specify the module to perform the the read test on from the drop-down list.

10.Change the [Test] setting to "Yes" for the data that is to be tested.  If an image is also to 
be displayed, change the [Image] setting to "Yes".

11.Click [Start Test] and the results of the test display in red.
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12.If skip marks are misidentified, check the result number and then click [Quit] to close the 
dialog box and then edit the data in MEdit based on the test results.

13.Retransmit the job back to the machine and then run the test read again.  Repeat until 
the skip marks are correctly identified.
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7. Fujitrax and the NXT
7.1 Introduction

The NXT is designed to support Fujitrax Verifier functionality with no special hardware 
modifications being required.  This allows the extra protection provided by Fujitrax Verifier 
to be added to the factory with a minimum of fuss and trouble while providing a high level 
of feeder verification and potential to reduce downtime.  There are two main functions for 
Fujitrax Verifier that is covered in this manual.  There are many other functions available in 
the software that are covered in detail in the Fujitrax Verifier Operation Manual.  The two 
main functions covered in this manual is feeder/part verification and low parts management.  

It is important to point out that Fujitrax procedures have not really been changed for the 
NXT.  The biggest change was the line configuration setup for the NXT in Verfier.  The main 
difference on the machine side for the NXT regarding Fujitrax is the ease of feeder checks 
and feeder detection. 
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MEMO:
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8. Fujitrax Verifier
8.1 Introduction

Fujitrax Verifier is used to perform two main functions.  The first main function is feeder/part 
verification.  The other major function is parts management.  There are many other 
functions available through Fujitrax Verifier, however these will not be covered in this 
manual because they are not different for the NXT machine.  For information on these 
functions and details on the items here, refer to the Fujitrax Verifier Operation Manual.

The feeder/part verification function is basically the same for the NXT from the software 
side, however the checking of the feeder set on the machine is different from most Fuji 
machines.  This change enables feeder changover to be checked quicker and with less 
operator intervention. 

Parts management informs the operators when parts are going to run out.  One of the 
biggest changes in regards to resupply is that the machine does not need to be stopped 
when feeders are replaced.  This allows an operator to prepare a new feeder with parts 
before the parts run out and as soon as they run out, the feeder can be switched without 
stopping the machine.  Another feature due to the feeder system, is the support for splicing 
with Fujitrax.  Fujitrax will inform the operator that a certain feeder needs to be spliced.  The 
operator gets the new parts and brings it to the correct feeder position.  Before splicing, a 
splicing verification check is performed to ensure the part is correct and then the new reel 
is spliced to the old reel and placed on the feeder.

8.2 Required Items
In order to use Fujitrax Verifier with the NXT, there are several required items.

• Fujitrax Verifier Central Server must be installed and running on the computer 
with the Kit Server.

• The NXT must be added to the line configuration for the computer with the Kit 
Server.

• The NXT Fujitrax configuration setting must be turned on.

• The NXT user must be added to the Kit Handy Settings when using Kit Handy.

Follow the procedures below to perform these actions.

8.2.1 Installing and setting up the Central Server
The Central Server requires no special installation steps when installing the Kit Server.  
This software is automatically installed when a compatible Kit Server version is installed on 
a computer.  In addition, this software should always be running whenever the computer is 
on because it is a service.  A few configuration settings must be specified.

1. Open the Fuji Central Server Settings program by using the shortcut in the start up 
menu.  When selected, the [Fuji Central Server Settings] dialog box is displayed.

2. Enter “FUJIADMIN” in the [User ID] text box and then enter the appropriate password 
for this user ID.

3. Enter service name for the Verifier Database.
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4. Specify the maximum desired log size for the Central Server from the [Log Size] drop-
down list.

5. Leave the default setting for [Miss Prevention Timer].

6. Specify the desired setting regarding quick verification.

7. Specify the name of the computer running the Fuji Flexa User Server in the [Flexa PC 
Hostname] text box.

8. Click [OK] and the dialog box closes.

9. Reboot the computer to enable the new settings.

8.2.2 Adding the NXT to the Fujitrax line configuration
Follow the steps below when adding the NXT to the Fujitrax Verifier line configuration.

1. Open the Kit Line Configuration program by using the shortcut in the start up menu.

2. Enter “FUJIADMIN” as the user ID and then enter the appropriate password and service 
name for the master database.

3. Click [OK] and the [Kit Line Configuration] window displays.

4. Select the Factory from the left pane and select [Add Line] from the [Edit] menu.

5. Specify the name of the NXT line in the [Line Name] data field and then specify the name 
of the computer running the central server for the NXT in the [KITServer Hostname] data 
field.

6. Click the new line in the left pane and the field updates to display the specified name.

7. Click [Add Machine] from the [Edit] menu.  The right pane changes to display the data 
fields for the new machine.

8. In the [Machine Nickname] field, specify the name of the NXT machine.  The name 
should match that used by Fuji Flexa for the machine.

9. Select [NXT] from the [Machine Type] drop-down list.

10.In the [Recipe Name, Top] and [Recipe Name, Bottom] fields enter the name of the 
base.  It does not matter that these settings are the same, because the NXT does not 
use these settings.  However, some value must be entered in these fields or an error will 
occur when trying to save the line configuration.

11.Specify the board flow direction and the parts out settings in the appropriate fields.

12.Enter the name of the computer running the Central Server for this base in the [Central 

Setting Description

Every time of 
removed feeder

This specifies that a quick verify check of a feeder and the 
parts must be performed before the feeder is set in the 
machine. This is required even if an ID (relationship) 
between the feeder and parts already exists.

Normal This specifies that a quick verify is not required before a 
feeder is set in the machine, however an ID (relationship) 
between the feeder and parts set on the feeder must exist.
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Server Name] field.  This should match the name used for the Kit Server for the line.

13.Specify whether dynamic alternate feeders are to be used or if splicing is to be 
performed for replenishing parts in the [Dynamic Alternate Feeder] field. 

14.That completes the settings for the machine items for Verifier.  Click the new machine 
in the left pane and the machine name updates to display the specified name.

15.Click [Add Base] from the [Edit] menu.  The right pane changes to display the data fields 
for the new base.

16.In the [Base Name] field, specify the name of the first NXT base for the machine.  The 
name should match that used by Fuji Flexa for the base.

17.Specify the base type using the [Base Type] drop-down list.

18.Click the new base in the left pane and the base name updates to display the specified 
name.

19.Click [Add Module] from the [Edit] menu.  The right pane changes to display the data 
fields for the new module.

20.Specify the module type by using the [Module Type] drop-down list.  Leave the other 
setting as is.

21.Click the new module in the left pane and the module name updates to display the 
specified module type.

22.Repeat steps 19 to 21 until all of the modules for that base have been specified.

23.Click the base, and if the NXT machine is comprised of multiple bases, click [Add Base] 
from the [Edit] menu.  The right pane changes to display the data fields for the new base.

24.Repeat steps 15 to 23 until all bases for the NXT machine have been specified.

25.If there are any other NXT machines on the same line then select the new NXT machine 
and repeat steps 7 to 24 until all NXT machines in the line have been specified.

26.If there are any other lines for this Kit Server with NXT machines, add the machines at 
this time.

27.Select [Save] from the [File] menu and then [OK], and the file is saved to the database 
and computers.

28.Select [Exit] from the [File] menu to quit Kit Line Configuration Editor.

Setting Description

OFF The dynamic alternate feeder function is not used and 
splicing is possible.

ON (Look For 
Removable)

The dynamic alternate feeder function is used and when 
the original feeder is removed, the alternate feeder should 
be placed in the original position when the machine 
indicates that it should be moved.

ON (Keep Alt 
Feeder)

The dynamic alternate feeder function is used, but the 
alternate feeder is not moved when the original feeder is 
removed.
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8.2.3 Setting the NXT Fujitrax configuration settings
Follow the steps below to change the setting on the NXT machine to work with the Fujitrax 
Verifier system..

1. Double-click the [Internet Explorer] icon on the desktop.

2. Enter the address (URL) "http://<NXT accessory software server name>/fujiweb" and 
then press Enter.  If the server computer is located and the server is running, a loading 
page displays.  Once the necessary items have been loaded, the [Home] page displays.  
This page provides basic production information for the NXTs.

3. From Floor Monitor, click the machine or module number for the NXT for which Machine 
Accessories is to be used.  The Machine Accessories log on page is displayed

4. Enter or select a user ID from the drop-down list.

5. Enter the password for the user and click [Log on].  Once connected to the machine, the 
top diagram of the picture will match the machine that was selected.  In the lower left 
side, the menu for possible actions displays.  In the lower right side, the details for the 
selected item displays.

6. Click [Machine Configuration] from [Menu].  Accessory Software connects to the 
machine and receives the machine information.  When completed, the settings page 
displays.

7. Select [Fujitrax Settings] from the [Category] drop-down list.  When a category has been 
selected the settings shown under the list automatically change to the selected 
category.  

8. Select the [ON] option for the [Use Verifier] setting.

9. Leave the other settings with their default settings unless special settings are required.  
For details on the settings, refer to the NXT Accessory Software Operation Manual.

10.Once the settings have been completed, click [Send to Machine] to send the new setting 
to the machine.  During transmission to the machine, the operation panel will change to 
the transmission display.  When sending the new setting is complete, a page displays 
with that message.  If any other changes need to be made, use the drop-down list to 
select the category for the setting.

11.Once all changed settings have been sent to the machine, click [Close].
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8.2.4 Registering users for Kit Handy access
Follow the steps below to allow the registered users to access the NXT information through 
Kit Handy.

1. Open Kit Manger by using the shortcut in the start up menu.

2. Enter “FUJIADMIN” as the user ID and then enter the appropriate password and service 
name for the master database.  It is necessary to log on with this ID to change the Kit 
Handy settings.

3. Click [OK] and Kit Manager starts.

4. Double-click the factory from the left pane and the lines for that factory display.

5. Double-click the line to display the machines for that line.

6. Select the NXT machine and then right-click.  A shortcut menu displays.

7. Select [Handy User Settings] from the shortcut menu.  The [Handy User Settings] dialog 
box for the selected machine displays.

8. Enter the user ID to be registered in the [User ID] text box.

9. Click [Add] and the entered user ID displays in the list.

10.Continue repeating steps 8 to 9 until all of the user IDs for that NXT have been 
registered.

11.Click [Close] to complete the user ID registration process.  The registered user IDs are 
now capable of accessing the information screens for that NXT.

12.Log off Kit Manager by selecting [Exit] from the [File] menu.
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8.3 Working With AVL Data
AVL data is a data type that is available in Fuji Flexa V2.0.1 and higher.  By using this data, 
it is possible to use parts that have the same function but come from different vendors and 
might have different part numbers, supply direction, and shapes without having to edit the 
job in production.  AVL stands for “Approved Vendor List”.

Each different part should be assigned a unique part number when there is a difference in 
the parts such as vendors, type of part, function, or shapes.  Due to this, there will be parts 
that perform the same function and maybe even have the same shape information but 
come from a diffferent vendor so the part number is different.  Previously, when a different 
part number that has the same function is to be used in production, the job had to be 
manually edited to change the old part number to the different part number.  This is due to 
the fact that to one slot and set of related sequences, one part number is assigned. 

By making AVL data that groups the approved part numbers, it is possible to quickly change 
the part to be used in a job that is using AVL data when not using Verifier.  This basically 
changes the job so that one feeder position and the related set of sequences can use 
multiple part numbers.  When Verifier is not being used for the NXT, the part number with 
the priority setting is the one that is to be used for production.

When Verifier is being used with NXT V3.10 and higher, the true power of the AVL data is 
realized.  When Verifier is used in confunction with AVL data on the NXT, the part number 
that can be used is not limited to the part number with the priority setting, but any part 
number within the AVL data.  This makes it possible to use any of the parts numbers for 
each AVL as parts for that job without having to edit the job*.  In addition, the possible parts 
that can be used are also list in the parts supply guidance.  During production it is even 
possible to verify and switch the parts used when the original runs out*.

Note: Refer to the Compatible items and limitations section for details on these items.

The procedures for when using AVL data have been added to the instructions in the 
following sections if any special procedure or point is required.

8.3.1 Required items
The following items are required in other to use AVL data with the NXT and fujitrax. 

• NXT using machine software V3.10 or higher

• Fuji Flexa version V2.0.1 or higher

• Fujitrax Verifier V3.03 or higher

• The AVL option turned on in Fuji Flexa in the Fuji Flexa Server Setup.

• AVL data registered in the AVL library for the items in the jobs.

• AVL data specified for the sequences in the job.
138 NXT Programming Manual



QD004-05 8. Fujitrax Verifier
8.3.2 Compatible items and limitations
The following table lists the current compatibility of AVL data.

The following is a list of the current limitations.

•  It is possible to use any of the parts in the AVL data, but only the part that has 
the priority setting can be used when performing a quick verification.  If other 
part numbers are to be used, it is not possible to currently quick verify those 
parts but a ID will have to be made for the relationship between the feeder and 
part.

•  It is not possible to quick verify the parts for the dynamic alternate feeder 
function when changing to a different part number during production.  An ID has 
to be created and then the feeder is set in the machine.  If the setting that a quick 
verify is required for all feeders, then the dynamic alternate feeder function 
cannot be used (unless this setting is turned off) for parts with different part 
numbers.  If the same part number is being used to replenish parts then it is 
possible to use quick verify for the dynamic alternate feeder function.

•  It is not possible to use splicing to splice together two different part numbers 
during production.  The operator simply replaces the feeder with a new feeder 
with the different parts on it (after creating an ID) in the machine when the 
original parts run out.  If the same part number is being used to replenish parts 

Item AVL 
Comp.

Description

Fuji Flexa Yes Fuji Flexa V2.0.1 or higher is required.

Fujitrax Verifier Conditions 
exist

Fujitrax V3.03 and higher supports AVL.  However, 
a quick verification cannot be used when changing 
the part number.  This is planned to be supportd in 
the future.

Dynamic 
Alternate 
Feeder

Yes Cannot perform a quick verify for parts that are using 
a different part number.

Splicing Conditions 
exist

Splicing can be performed when the original parts 
and new parts are using the same part number.  
When the part number is changed, splicing cannot 
be performed.  The original parts have to run out and 
then switch the feeder with a new feeder with the 
different parts.

Dual Lane 
Production

Yes

Fujitrax Profiler Yes

Tray Unit-L No

Stick Feeder No

MEdit No

Automatic 
Changeover 
Function

Yes
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then it is possible to splice them together.

• It is not possible to use this AVL function for tray parts or stick parts.

• It is not possible to use MEdit to edit AVL data.

• If the NXT is not using machine software V3.10 or higher, the only parts that can 
be used in production are the parts with the priority settings.
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8.4 Creating Relationships Between Feeders and 
Reels

It is essential to create IDs or to perform a quick verify before setting parts on a machine.  
Creating IDs and performing a quick verify create relationships between reels and feeders.  
Before performing this, the parts DID and feeder barcodes must already be registered in 
the Fujitrax Verifier database or an error will occur while making an ID or performing a quick 
verify.

8.4.1 Creating IDs
This is used to just create an relationship between the part and the feder in which the part 
is set.  An ID can be created between a part and a feeder at any time.  When an ID is 
created, this simply creates a relationship and performs no other checks such as if the part 
is actually the desired part or not.  If the Central Server option is set in which a quick 
verification is required before a feeder can be set on the machine, use the quick verify 
method instead for jobs in the foreground or use external changeover for setting up feeders 
for jobs not in the machine.

If AVL data is being used and a different part to the one that has the priority setting is being 
used, the relationship between the feeder and reel has to be made this way at this time.

Using Kit Manager
1. Open Kit Manger by using the shortcut in the start up menu.

2. Enter a user ID and then enter the appropriate password and service name for the 
Verifier database.

3. Click [OK] and Kit Manager starts.

4. Double-click [Database] in the left pane.  The items for this group display.

5. Click the [ID] folder to make it active.

6. Scan the DID barcode for the part.  The [ID] dialog box displays with the scanned DID 
in the [DID] text box.

7. Scan the barcode on the feeder.  The data is entered into the [FIDL] text box and if no 
errors occur, the dialog box is automatically closed.  The new ID relationship displays.

8. Continue registering IDs until relationships between all feeders and parts for the job 
have been completed.

Using Kit Handy
1. Start the Fuji Information Terminal and tap the Windows mark to display the [Start 

Menu].  Tap [Kit Handy] to display the [Log on] screen.

2. Enter or scan the user ID and tap [OK].  The Kit Handy menu displays.

3. Tap [ID] and the ID creation screen displays.

4. Scan the DID of the part on the feeder.  The scanned DID displays in the [DID] text box.

5. Scan the feeder barcode and the result is entered in [FIDL] text box.  If no errors occur, 
the dialog box automatically closes.

6. Repeat these procedures as necessary for the other feeders.
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8.4.2 Performing a quick verify
This can only be performed for feeders that are in the current job.  This cannot be performed 
for feeders to be used in the next job or jobs not in the machine.  To set up feeders for such 
jobs, use External Changeover.  This creates a relationship between the feeder and the 
part, and checks to ensure that the scanned part is the correct part for that position.  This 
currently cannot be used if AVL data is being used and the part number being used is not 
the part number in the AVL data with the priority setting.

Using Kit Manager
1. Open Kit Manger by using the shortcut in the start up menu.

2. Enter a user ID and then enter the appropriate password and service name for the 
master database.

3. Click [OK] and Kit Manager starts.

4. Double-click the factory folder in the left pane.  The lines for this factory display.

5. Double-click the line with the NXT to be set.  The machines for that line display.

6. Select the NXT machine on which to perform the Quick Verify.

7. Select [Quick Verify Mode] from the [Command] menu.

8. Select the feeder position for which to perform the quick verify.

9. Scan the DID of the part on the feeder that is for the selected position.  The [Quick Verify] 
dialog box displays with the scanned DID in the [DID] text box.

10.Scan the feeder barcode and the result is entered in [FIDL] text box.  If no errors occur, 
the dialog box automatically closes and a blue round icon displays in front of that feeder 
position.

11.Repeat these procedures for the other feeders.

Using Kit Handy
1. Start the Fuji Information Terminal and tap the Windows mark to display the [Start 

Menu].  Tap [Kit Handy] to display the [Log on] screen.

2. Enter the user ID and tap [OK].  It is possible to also scan the user ID.  The Kit Handy 
menu displays.

3. Tap [Device Check] and the machine specification screen displays.

4. Enter or scan the name of the NXT machine for which to perform the device check and 
tap [OK].

5. Tap [Mode] from near the top of the display and then tap [Quick Verify].

6. Tap the device for which to perform the quick verify to select that device. 

7. Scan the DID of the part on the feeder that is for the selected position.  The screen 
changes to display the scanned DID in the [DID] text box.

8. Scan the feeder barcode and the result is entered in [FIDL] text box.  If no errors occur, 
the dialog box automatically closes and a blue icon displays for that feeder position.

9. Repeat these procedures for the other feeders.
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8.5 Performing a Device Check
If there is a vision error or pick up errors for a feeder, a device check is required for that 
position before production can be resumed.  Follow the procedures below to perform a 
device check.

8.5.1 Using Kit Handy
1. Start the Fuji Information Terminal and tap the Windows mark to display the [Start 

Menu].  Tap [Kit Handy] to display the [Log on] screen.

2. Enter the user ID and tap [OK].  It is possible to also scan the user ID.  The Kit Handy 
menu displays.

3. Tap [Device Check] and the machine specification screen displays.

4. Enter or scan the name of the NXT machine for which to perform the device check and 
tap [OK].

5. Tap [Mode] from near the top of the display and then tap [Device Check].

6. Tap the device for which to perform the device check to select that device.  This position 
should have an error icon and be a different color due to the error condition.

7. Scan the DID of the part on the feeder that is for the selected position.  The screen 
changes to display the scanned DID in the [DID] text box.

8. Scan the feeder barcode and the result is entered in [FIDL] text box.  If no errors occur, 
the dialog box automatically closes and the error status is cleared.  Production can 
resume using this feeder.
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8.6 Checking the Device Statuses
From Kit Manager or Kit Handy, it is possible to check the current condition of the devices 
on the machine.  Follow the procedures below to check the devices on the machine.

8.6.1 Using Kit Manager
1. Open Kit Manger by using the shortcut in the start up menu.

2. Enter a user ID and then enter the appropriate password and service name for the 
master database.

3. Click [OK] and Kit Manager starts.

4. Double-click the factory folder in the left pane.  The lines for this factory display.

5. Double-click the line with the NXT to be checked.  The machines for that line display.

6. Select the NXT machine for which to check.  The right pane changes to display the 
devices for the machine.  Scroll through the devices to check the different positions.  It 
is also possible to sort the devices based upon a heading by double-clicking that 
heading.

8.6.2 Using Kit Handy
By following the procedures below, all of the feeders for the selected machine displays.  In 
addition, if a parts out warning occurs, these warnings are also displayed in the Parts Status 
screen for all machines for which the user is registered. 

1. Start the Fuji Information Terminal and tap the Windows mark to display the [Start 
Menu].  Tap [Kit Handy] to display the [Log on] screen.

2. Enter the user ID and tap [OK].  It is possible to also scan the user ID.  The Kit Handy 
menu displays.  The bottom of the screen will display special icons if any parts warnings 
or machine errors have occurred on the machines for which the user logged in is 
registered.

3. Tap [Device Check] and the machine specification screen displays.

4. Enter or scan the name of the NXT machine for which to check and tap [OK].  The screen 
changes to display the condtions of the current devices.  Scroll through the list to check 
the different positions.
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8.7 Resupplying Parts During Production
There are several methods for resupplying parts during production.  The first uses dynamic 
alternate feeders to resupply parts for feeder.  The second method is to splice the new tape 
and old tape together before the feeder runs out of parts.  The third method available for 
feeders is simply waiting for the feeder to run out of parts and then replace the feeder with 
another feeder already set with the same part.  For trays, there is a method for resupplying 
parts without stopping production.

8.7.1 Replacing feeders using dynamic alternate feeders
Fujitrax Verfier issues parts out warnings based upon the user specified settings.  When a 
parts out warning occurs, the operator has time to get a new reel, set it on a feeder, and 
perform a quick verify.  Once these steps are performed, the feeder is set in the module in 
which the warning was issued and the machine checks that feeder position and 
automatically converts that feeder into a alternate feeder.  When the original parts have run 
out, parts are then picked from the alternate feeder and the original feeder is removed.  
From this point, there are two different procedures performed depending on the dynamic 
alternate feeder setting specified in the Kit line configuration.  Splicing and dynamic 
alternate feeders cannot be used at the same time on the machine.

If AVL data is being used, quick verify for the dynamic alternate feeder function can only be 
used to replenish parts have the same part number as the original parts.  If the parts have 
different part numbers, then an ID is made, but if the Central Server setting that a quick 
verify is required for all parts is on, then this setting needs to be turned off or different part 
numbers cannot be supplied using the dynamic alternate feeder function.

1. A parts out warning is issued and seen from one of the various locations, the NXT 
operation panel, from one of the Kit Manager status displays, or from the Kit Handy Parts 
Status or Device Check screens.

2. Obtain a new reel of matching parts and set on a new feeder.

3. Quick verify the parts and feeder using Kit Manager or Kit Handy.  Due to this step, when 
the feeder is set on the machine, the machine will be able to determine the part loaded 
on the feeder.  If the part number is different then create an ID.

4. Set the feeder in an empty slot in the module with the parts on which the parts out 
warning occurred.  If the set green and orange LEDs light, verification was successful 
and the feeder status was changed into an alternate feeder. 

5. Once the original feeder runs completely out of parts and the machine starts picking 
from the alternate feeder.  The original feeder set LED turns red.

6. Remove the orignal feeder after the red set LED is lit.  The actions that occur next 
depend on the settings in the Kit line configuration for Alternate Feeder.

Note: When removing feeders, it is essential that the clamp lever is raised all of the way and kept in that 
condition when the feeder is pulled out.  If the clamp lever is not completely raised, it is possible that the 
power to the feeder is not disconnected.  If the feeder is removed with power still being supplied, the 
connector can become bad and the internal feeder board can be damaged.

Note: The machine does not need to be stopped to remove a tape feeder.
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If the alternate feeder setting is “ON (Look for removable)”
1. When the original feeder is removed, the LED for that position begins to blink and the 

LED for the alternate feeder changes to red and the feeder must be removed (it 
becomes a "removeable feeder").  Once the alternate feeder LED turns red, remove the 
alternate feeder.

Note: If multiple dynamic alternate feeders are set for the same part, the status of all of the set feeders 
becomes "removeable".

Note: When removing feeders, it is essential that the clamp lever is raised all of the way and kept in that 
condition when the feeder is pulled out.  If the clamp lever is not completely raised, it is possible that the 
power to the feeder is not disconnected.  If the feeder is removed with power still being supplied, the 
connector can become bad and the internal feeder board can be damaged.

2. Quickly place the alternate feeder in the original feeder slot within the “miss preventation 
timer” setting time limit in the Central Server (default: 40 seconds).  If the feeder is set 
properly in the original slot within that time limit, the set LED turns green and the feeder 
can be used.  If it is not set within that time frame, quick verify the feeder again and set 
it in the original feeder’s slot.  Resupply is complete.

Note: When there are multiple alternate feeders, only remove one of the alternate feeders.  If two or more 
feeders are removed, the feeder guidance will not display correctly.

If the alternate feeder setting is “ON (Keep Alt Feeder)”
The alternate feeder is continued to be used as is until a feeder is set back in the original 
feeder’s slot.  When parts are set back in the original slot. the machine then picks parts from 
the original slot.  This means that the alternate feeder is only used as long as there is no 
feeder in the original slot.

8.7.2 Splicing tape
Fujitrax Verfier issues parts out warnings based upon the user specified settings.  When a 
parts out warning occurs and splicing is to be performed, the operator has time to get a new 
reel and splice it to the old reel before the parts run out.  During splicing, a check is 
performed to ensure that the parts are correct.  If the parts are correct, then the feeder 
status is automatically changed.

When using AVL data, splicing can be performed as long as the new tape being spliced to 
the old reel has the same part number as the original reel.  If a different part is to be 
supplied, then the procedures for the next section 7.7.3 have to be followed so that the 
original feeder runs out of the parts and then the feeder is removed and a new feeder with 
the different parts is supplied.

1. A parts out warning is issued and seen from one of the various locations, the NXT 
operation panel, from one of the Kit Manager status displays, or from the Kit Handy Parts 
Status or Device Check screens.

2. Obtain a new reel of matching parts.

3. Start the Fuji Information Terminal and tap the Windows mark to display the [Start 
Menu].  Tap [Kit Handy] to display the [Log on] screen.

4. Enter the user ID and tap [OK].  It is possible to also scan the user ID.  The Kit Handy 
menu displays.

5. Tap [Device Check] and the machine specification screen displays.

6. Enter or scan the name of the NXT machine on which to perform the splicing and tap 
[OK].
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7. Tap [Mode] from near the top of the display and then tap [Splicing].

8. Tap the device to which to splice the new reel to select that device.  This position should 
have an error icon and be a different color due to the error condition.

Note: If using 2 point verification mode on the Kit Handy, first scan the DID of the reel that the new parts are 
to be supplied to instead of selecting the splicing position from the screen.

9. Scan the DID of the new reel to be spliced.  A check is performed and if the part is 
correct, a message box displays asking if splicing has been completed.  From this point, 
splice the tape together.  If an error occurs, the part is not correct and a different reel is 
needed.

10.Splice the tape together and wrap up the old tape on the new reel and set in the feeder.  
For details on performing the actual splicing operation, refer to the NXT Operator 
Manual.

11.Tap [Yes] and the message box closes.  The feeder status automatically changes.

8.7.3 Replacing feeders
Fujitrax Verfier issues parts out warnings based upon the user specified settings.  When a 
parts out warning occurs and the feeder is to be replaced, the operator has time to get a 
new reel, set it on the replacement feeder, and create an ID or perform a quick verify.  Once 
these steps are performed, when the NXT machine announces that the parts have run out, 
the feeder can be quickly replaced.  The machine checks to ensure that the parts are 
correct and if they are, the feeder status is automatically changed and the feeder can be 
used.

When using AVL data, this is the method that must be currently used for splicing if the 
replenishment part has a different part number to the original part.

1. A parts out warning is issued and seen from one of the various locations, the NXT 
operation panel, from one of the Kit Manager status displays, or from the Kit Handy Parts 
Status or Device Check screens.

2. Obtain a new reel of matching parts and load them on a new feeder.

3. Create an ID using Kit Manager or Kit Handy (an ID must be created if using AVL data 
and the part number is different than the original part) or quick verify the parts and feeder 
using Kit Manager or Kit Handy.  Due to this step, when the feeder is set on the machine, 
the machine will be able to determine the part loaded on the feeder.

4. Set the feeder near the machine.

5. The old feeder runs completely out of parts and warnings are issued on the NXT 
operation panel, Kit Manager, or Kit Handy.  Once the set OK LED for the old feeder 
changes to red, remove the old feeder.

Note: When removing feeders, it is essential that the clamp lever is raised all of the way and kept in that 
condition when the feeder is pulled out.  If the clamp lever is not completely raised, it is possible that the 
power to the feeder is not disconnected.  If the feeder is removed with power still being supplied, the 
connector can become bad and the internal feeder board can be damaged.

Note: The machine does not need to be stopped to remove a tape feeder.

6. Set the new feeder that had the ID created with the parts already loaded in the old feeder 
slot.  If the parts are correct, the feeder status automatically changes and the feeder can 
be used.
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8.7.4 Replacing trays with non-stop tray resupply (from NXT V3.10)
Fujitrax Verfier issues parts out warnings for the tray unit-L based upon the user specified 
settings.  When a parts out warning occurs for a tray, the operator has time to get a new 
tray, set it in a replacement drawer, verify it, and set it in the parts supply drawer.  Once the 
drawer with the original tray runs out of parts, that drawer is moved to the parts removal 
area and the drawer set in the parts supply area is moved to the original drawer position 
without stopping production.

AVL data cannot be used for trays.

Required items
The following items are required in other to use the non-stop tray resupply function to 
resupply trays during production. 

• NXT using machine software V3.10 or higher

• Fujitrax Verifier V3.04 or higher

• The NXT machine configuration options, [Use Verifier] and [Perform tray 
verification] must both be set to “ON”.

• The [Tray Supply] option for the NXT module configuration for the module with 
the tray unit-L must be set to “Use tray removal area”.

• In the Kit line configuration, verification is being used for the module with the tray 
unit-L.

Tray arrangement
While it is possible to put two different trays in one drawer, Fuji recommends arranging trays 
in a 1-tray-per-drawer format in order to ensure that trays are used in an efficient manner 
(so trays that are still in use are not unloaded), and to ensure that accurate part 
replenishment guidance messages are sent for resupplying parts when using the non-stop 
tray resupply function.

If alternate trays are to be used, put the alternate tray in the same drawer as the original 
tray (see 3.3.6 in this manual for information about making alternate positions in Fuji Flexa).  
If the alternate tray is set in another drawer, the parts out guidance messages will not be 
correct, because the parts out warning time is calculated based on the total number of parts 
in the original and alternate trays.  Be sure to also set new alternate trays when resupplying 
trays in spare drawers.

Resupplying trays during production
1. A parts out warning is issued and seen from one of the various locations, the NXT 

operation panel, from one of the Kit Manager status displays, or from the Kit Handy Parts 
Status or Device Check screens.

2. Obtain a new tray of matching parts and position it in a spare drawer.

Note: If using an alternate tray, be sure to also set that tray before continuing on to the next step. 

3. Start the Fuji Information Terminal and tap the Windows mark to display the [Start 
Menu].  Tap [Kit Handy] to display the [Log on] screen.

4. Enter the user ID and tap [OK].  It is possible to also scan the user ID.  The Kit Handy 
menu displays.
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5. Tap [Device Check] and the machine specification screen displays.

6. Enter or scan the name of the NXT machine on which to perform the splicing and tap 
[OK].

7. Tap [Mode] from near the top of the display and then tap [Splicing].

8. Tap the tray position for which the warning was issued to select that position.  This 
position should have an * and error icon and have a "PartsE" or "PartsOutWarning" 
status and be a different color.  The tray being resupplied should be the part that is going 
to run out the quickest.

Note: The non-stop tray resupply function cannot be used to resupply trays for errors other than parts out, 
such as pickup miss.  In such a case, it is necessary to stop production and open the door to check trays 
and perform other tray operations. 

9. Scan the part number of the new tray set in the spare drawer.  A check is performed and 
if the part is correct, the dialog box is closed.  If an error occurs, the part is not correct 
and a different tray is needed.

Note: If using alternate trays, be sure to also verify that tray before continuing on to the next step. 

10.Open the part supply drawer and set the spare drawer with the verified trays in it.

Note: Ensure that the set drawer is properly set in the parts resupply drawer, and be sure to gently close the 
part supply drawer.  Closing the drawer in an abrupt manner can scatter the parts. 

11.Gently close the parts supply drawer and the machine picks up the drawer and checks 
the height of the trays.  If the height check has no errors, then resupply of that drawer is 
complete.  If an error occurs, the drawer is returned to the parts supply drawer.  Recheck 
and verify the trays again.

12.Production continues until all of the parts in the original tray have been used.  Once all 
of these parts have been used, the drawer in which the part are set is moved to the tray 
removal area and the new drawer is pulled out on the shuttle.  Once the pulled out 
drawer is finished being used, it will be moved to the original drawer position in the tray 
unit.  Remove the drawer with the empty trays from the tray removal area.

Note: If a drawer is in position 21 (the position that trays picked from the parts supply drawer are kept until the 
original parts run out) and this drawer needs to be removed from the machine for some reason, use the 
panel removal command from the manual mode commands.  When this command is started, any 
drawers in position 21 are returned to the parts supply drawer (if it is empty).  It is not necessary to 
actually remove the tray unit and pull forward the module, just push CANCEL to cancel the rest of the 
command. 

Precautions
Be sure to note the following points when using non-stop tray resupply. 

• Do not transmit a different job to the machine when a drawer is in slot 21.  If the 
machine is changed to a different job while a drawer is present in Slot 21, use 
the panel removal command from manual mode to unload the slot 21 drawer to 
the parts supply drawer and then remove the drawer. 

• The supply and removal area doors are locked when the magazine is in their 
vicinity.  The parts supply drawer is also locked when a drawer is present in Slot 
21.  The parts removal area door is locked if there are no drawers in the removal 
area.
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• If a height check error occurs for parts replenished to the parts supply drawer, 
the drawer is returned to the parts supply drawer, but "SetOK" remains 
displayed on Kit Handy.  Check the tray height, and verify the parts again with 
Kit Handy. 

• The non-stop tray resupply function cannot be used to resupply trays for errors 
other than parts out.  In such a case, it is necessary to stop production and open 
the door to check trays and perform other tray operations.  
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Glossary
A

alternate feeder
An empty slot on a feeder table can be readied with the same part that is being supplied 
from another feeder position.  When the original feeder runs out of parts, the pick-up 
position changes to this alternate feeder.  Multiple alternate feeders can be specified.  
When an alternate feeder runs out of parts the next alternate feeder in the loop is used.  If 
the feeder is the last feeder in the loop then the original feeder is used again.

assign
This is found in the coordinate data in the job and specifies which machine is to use the 
mark or place the part/glue dot.

B
background
An portion of the machine's memory used to stores recipes that aren't being used. A 
"background" recipe is a recipe at a Conversely, active recipes are referred to as 
"foreground" recipes.

board
The smallest independent unit of a printed circuit board on which electronic components are 
placed

BOM file
An acronym for "Bill Of Materials". The BOM file containes data such as part numbers for 
each location that corresponds to a reference designator on the board. this file may contain 
extra fields to add to the job's part data.

C
C/C
Networking software that facilitates communication between Fuji Flexa and placing 
machines. Text data transmitted by the Transmission Server application is passed to the C/
C, which converts the text data into binary data that can be transmitted to machines. The 
C/C also converts binary data received from machines into text data

CAD file
A file which is output from a CAD system. This file generally contains the reference 
designators, X,Y coordinates, and angles, etc., for each location on the board.

calibration data
Machine-specific data that is required for a machine to operate. An example of calibration 
data would be the data that defines the spatial relationships between various machine 
components.  
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CCIMF format
An intermediary file format.  F4G programs and part data translated by Port Wizard are 
output as CCIMF files.  Recipes from FujiCam are in CCIMF format.

centroid CAD
This is a text file that has the coordinates and reference designators for parts.  Each line in 
the file has data for one part only.  Sometimes other data is present such as the part 
number, panel side.

coordinate data
Data that displays in Job Builder, that has the position data and other necessary settings 
for each part, mark, and glue dot. 

D
Director
The Fuji Flexa component that is used for data management, transmission, and managing 
factory lines and machines.  In addition, this provides easy access to many of the other 
Flexa components

E
element
A group of leads on the same side of a part which have the same length, width, and pitch. 

F
fiducial mark
A mark that is used to adjust the positioning when parts are placed on a board. Fiducial 
marks are printed onto the substrate together with the circuit pattern, thereby creating a 
constant indicator of the pattern's present location. There are 3 types of fiducial marks: part 
fiducials, board fiducials, and panel fiducials.

Fuji Flexa
This a production line host system for creating, editing, transmitting recipes to Fuji SMT 
machines.  In addition to the recipe management functions, the system is used for 
monitoring the production status of the machines and managing machine specific data.

G
global job
A job that is saved on the Job Server and is accessible to all users of that User Server

glue mark
These are for glue machines only.  At the beginning of production, trial check glue dots can 
be produced by the machine to ensure that the glue volume is correct.  The data for glue 
mark is used to check the size of the trial check glue dots.  If the trial check glue dots are 
not the correct size, the glue application air pressure is adjusted.
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I
Icon Bar
By default this displays to the left of the Director screen below the toolbar.  The icon bar is 
divided into groups, each is opened by clicking the group name on the gray button.  By 
clicking an item in the icon bar, it is possible to change the Director display, perform an 
action, or open a program

J
job
All the data that is required for the production of a single panel, stored in a single group.

job builder
The Fuji Flexa component that is used to create and edit jobs.

job information bar
By default, this is positioned at the left side of the window.  This organizes the data in a job 
into an easy to use format.  The information in the bar is split into groups: General, Part 
Data, Mark Data, and Top.  If relational mode is enabled then the tabs, Shape Data and 
Package Data also display.  Data within a tab is arranged in a hierarchical format.

job server
This is a server ran on a computer and specifies the location of the global jobs and manages 
access to those jobs.  This server retrieves jobs for users and also locks jobs so that no 
other user can alter a job while it is opened by the first user.

L
line balance
A process whereby tasks are distributed among the machines on a production line.  This is 
performed to attempt to make the working time for each machine on the line to be as close 
as possible

line configuration
Data describing the types of machines that make up lines and their special settings.  This 
also describes all of the lines for the factories and the their order.

Line Editor
The Fuji Flexa component used to create and edit the line configuration.

Line Monitor
The Fuji Flexa component used to monitor the real time production performance of entire 
lines and individual machines in the line configuration.

Line Reporter
The Fuji Flexa component used to generate production reports according to specified 
settings.  Reports can be prepared for obtained production data up to 7 days (i.e., 168 
hours) prior to the time of report generation.
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line server
This is a server ran on a computer and specifies the location of the line configuration files 
and manages access to these files.

local job
A job that is stored on a local computer .  This job is not managed by the Job Server and is 
not accessible to any other users.

M
machine configuration
A file that specifies the configuration, process options, available nozzles and feeders for a 
machine. Each machine in the line must have a configuration with the specific parameters 
for that machine. 

macro
Sets of instructions that are automatically performed when activated.

Macro Manager
The Fuji Flexa component used to create, modify, save, and run macros

mark data
There are five different types of mark data.  They are fiducial marks, skip marks, glue marks, 
mask marks, and panel ID marks

Mark Editor
The Fuji Flexa component used to create and edit mark data.

mark library
The library in which mark data is stored.  The part data server manages access to this 
library.

mask mark
These are marks used by printing machines to align the printing stencil with the board.  The 
printing machine inspects the fiducial marks on the board and mask marks on the stencil 
and then adjusts the stencil position to compensate for any misalignment between the two.

MCSIMF format
An intermediary file format.  MCS programs and part data translated by Port Wizard are 
output as MCSIMF files.

menu bar
This displays below the title bar for programs.  Commands are organized into groups and 
these group names display on the menu bar.  By clicking a name, the menu with the 
commands for that group displays.  Click an item to perform that command.

Model name
The Model name is a generic machine name that is used when using multiple lines with 
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identical line and machine configurations (including nozzles, parts supply unit etc.).  This 
allows users to use the same recipe from machine to machine when producing identical 
panels on multiple lines.

N
non-relational mode
This is a mode used for part data.  When this mode is used the "Part Number", "Shape 
Name" and "package Name" data is all saved under the one file name. there is no 
interlinking between the different part data this mode prevents user from accidentally 
editing package and shape data for various part at one time and is similar to Fuji's previous 
host system, MCS. This mode is specified in Flexa Server Setup in the [System settings] 
dialog box on the computer running the user server.

Nozzle Mapper
The Fuji Flexa component that is a conversion tool designed to convert the nozzle settings 
for part data when importing Port Wizard translated CCIMF or MCSIMF data from F4G or 
MCS into Job Builder.

O
optimization
The process where machine instructions are reordered so that the machine operates 
optimally. Normally, the processing sequence and feeder positions are rearranged in a 
manner that minimizes the machineís working time. 

P
package data
Data that describes packaging used for parts.  The packageís type. dimensions, pitch, and 
other parameters that a machine needs to process that package for the part that uses that 
data.  This data is comprised of two groups of data, package information, and package 
process.

Package Editor
The Fuji Flexa component that is used to create and edit package data.  This editor is only 
available if relational mode is enabled from the Flexa Server Setup.

package information
Data that has the settings that are used to describe the package.  The package's pitch, 
dimensions, and type are examples of settings found in package information.  This is one 
of the groups of data that makes up package data.

package library
The library in which package data is stored.  This library is only accessible if relational mode 
is enabled in Flexa Server Setup.  The part data server manages access to this library.

package process
Data that has the settings on how the packaging using that data is to be processed by the 
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machine.  Feeder options, reel diameter, and do advanced vacuum are examples of 
settings found in package process.  This is one of the groups of data that makes up package 
data.

panel
The entire printed circuit board (PCB) upon which electronic components are placed. A 
panel may be composed of one or more actual boards.

part data
All part data items.  This refers to data for the part number, shape data, and package data 
if relational mode is enabled.  If it is not enabled, then shape data and package data is not 
displayed.

part data server
This is a server ran on a computer and specifies the location of the part data files and 
manages access to these files.

Part Editor
The Fuji Flexa component that is used to create and edit part data.  If relational mode is 
enabled from the Flexa Server Setup, this editor is used to create and edit part number 
data.  If non-relational mode is used, this editor is used to create and edit all part data

part library
The library in which part data is stored.  The part data server manages access to this library

part templates
These are sections of part data that have been created to be used for future part data 
creation.  Part templates can be imported into part data reducing the amount of data input 
necessary when creating new data.  After importing the template, only the data that differs 
from the template needs to be edited.  Templates can be created for "Shape Information", 
"Shape Process", "Package Information" and "Package Process" data.

Part Template Editor
The Fuji Flexa component that is used to create and edit part templates.

R
recipe
Operation instructions for individual machines, created after the completion of line 
balancing and optimization processing. In the past, Fuji has referred to recipes as 
"Production programs".

relational mode
This is a mode used for part data.  This mode allows a "Part number" to be alinked to a 
shared "Shape" and "package". The relational mode allows multiple "part number" records 
to use the same shape data record and/or package data, thus minimizing the size of the 
libralies. in addtion, by editing  a packageing or shape record that is accessed by multiple 
part numbers, all the part data for all the part numbers are updated at one time. This is 
similar to Fuji's previous host system, FujiCam. When this mode is active, three 
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components are used to create and edit the different data. This mode is specified in Flexa 
Server Setup in the [System settings] dialog box on the computer running the user server

S
Schedule Assembler
The Fuji Flexa component that is used to associate schedule tables and ID code tables with 
production lines, viewing the current tables, and changing the next recipe to be used from 
a schedule table for HELPS machines.

Schedule Builder
The Fuji Flexa component that is used to create and edit schedule and/or ID code tables 
for HELPS machines

Schedule Viewer
The Fuji Flexa component that is used to display the schedule and ID code tables 
associated with HELPS lines and machines.

SECS/GEM
Networking software that facilitates communication between Fuji Flexa and placing 
machines. Communication is performed over an Ethernet cable.

shape data
Data that describes a part's dimensions, the quantity and size of pins (leads), and other 
parameters that a machine needs to process a part that uses that data.  This data is 
comprised of two groups of data, shape process and shape information.

Shape Editor
The Fuji Flexa component that is used to create and edit shape data.  This editor is only 
available if relational mode is enabled from the Flexa Server Setup.

shape information
Data that has the settings that are used to describe the part.  The part's dimensions, the 
quantity and size of pins (leads), and element information are examples of settings found 
in shape information.  This is one of the groups of data that makes up shape data.

shape library
The library in which shape data is stored.  This library is only accessible if relational mode 
is enabled in Flexa Server Setup.  The part data server manages access to this library.

shape process
Data that has the settings on how a part using that data is to be processed by the machine.  
Lead process data, vision type, pick-up offsets are examples of settings found in shape 
process.  This is one of the groups of data that makes up shape data.

skip
This is a setting found in the coordinate data.  When this is set to "Yes" for a record, the 
park or glue dot for that record will not be placed. If this is for a mark, the machines will not 
use that mark.
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skip mark
A mark that is placed on a multi-board panel to prevent a machine from processing one of 
the boards on the panel. When a job includes an instruction to read a skip mark, the fiducial 
mark camera takes an image of the specified coordinates and looks for a mark made using 
a pen or a sticker. If a mark is detected, the machine does not process that board. The panel 
is ejected from the machine once any other boards have been completed.  If the mark is for 
a panel and it is determined that the mark is present then the skip marks for the boards on 
the panel are checked.  If the panel skip mark is determined to not be present then the 
machine skips reading any other skip marks and proceeds with reading fiducial marks.

status data
Data that determines how the machine will function in the event of an error and specifies 
the state of communications between the machine and the host computer.

Spec Keeper
The Fuji Flexa component that is used for creating, merging, and editing spec data.

spec data
This is data about the specifications of feeders, needles, nozzles, and nozzle stations.

T
title bar
This displays at the very top of all windows. The program and/or item's name displays here 
and buttons to minimize, resize, and close the window are available in the title bar.

toolbar
Many Flexa components have bars with buttons that display below the menu bar.  Common 
commands can be performed by clicking the appropriate button on a toolbar. 

Trace Viewer
The Fuji Flexa component that displays log, and replay data generated by Fuji Flexa.  It also 
provides the ability to "peplay" certain events and to "package" a replayable event into a file 
that then can be used on another computer.

transmission
The process of sending recipes, calibration data, and other items to the machines.

U
user server
This is a server ran on a computer and is responsible for checking the Fuji Flexa licenses 
and for managing security.  In addition, the user server specifies which computers are 
running the three data servers.  For each license group there is only one user server.  Data 
between different user server groups cannot not be shared except by exporting the data 
from one group and then importing it into the other group.
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V
verify check
This is performed when the outline of the parts is available from Gerber CAD data or from 
the original CAD data.  When this is performed a dialog box displays with the outline of the 
part or pads from the CAD data and the part from Fuji Flexa superimposed.  If the 
positioning or rotation of the part from Fuji Flexa does not match the image from the CAD 
data then the positioning of the part can be adjusted until it matches

view mode
This indicates what data is being displayed in the window.  Director has seven different view 
modes.  The different view modes are used to perform different actions.

view mode bar
This displays between the toolbar and the data display panes in Director.  The left side of 
the bar indicates which of the view modes is active, and the right side of the bar displays 
the user ID of the current user.

virtual line
This is a line than does not actually exist in the local factory.  This line is used to create 
programs for a remote (unconnected) line, or for future line configurations that do not 
currently exist.  Virtual Line is the same as "Offline Descripter" in MCS
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FUJI Internet

Fuji Internet aims at providing up-to-date information to our customers in 
the most efficient manner.  This site makes a range of services available, 
from manual updates and virtual training, to online technical reports.  Fuji 
hopes that this site will be used as a source of information in addition to 
the services provided by your agent.  
Fuji Internet is located at http://www.fuji.co.jp/
Fuji Internet membership is required to access the Technical Information 
section of the site.  Please contact your agent for membership details.  
At any comments or opinions regarding this document can be sent to 
intnetqst@fuji.co.jp
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